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to understand a hazard.
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where hazardous voltage is present. 
Only trained service persons should 
perform work in this area.

If present, this symbol is placed on 
the OfficeJet Pro within the area 
where electrostatic discharge (ESD) 
may occur. ESD can damage the 
OfficeJet Pro’s electronic 
components. Avoid touching 
electronic components or circuit 
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when circuits are open to outside 
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Welcome! 1
Congratulations! You have just purchased the one system that will 
handle all your crucial office functions efficiently—the 
HP OfficeJet Pro. 

With your HP OfficeJet Pro, you can copy, print, or scan documents in 
full color or in black and white.

Copying Features
You can produce high-quality color and black and white copies, using 
a variety of paper types and sizes, including iron-on transfers.

You can enlarge or reduce the size of the copies you make, from 25% 
to 400% of the image’s original size. You can make the image lighter 
or darker, adjust the color intensity, and specify the quality of the 
copies you make. You can also use special digital copying features to 
help you create business cards, brochures, name badges—even 
posters. And you’ll be able to load up to 30 originals at a time in your 
automatic document feeder.

Printing Features
You can print in color or in black and white on a variety of paper types 
and sizes. 

Scanning Features
You can scan pictures and text up to 8.5 x 11.69 in. (210 x 297 mm) 
for use in all your documents.



1-2 Welcome!

About This Guide
This User’s Guide will help you get started and will show you how to 
perform the most common tasks with your HP OfficeJet Pro. 

If you find you need additional information, use the 1170C Series 
Toolbox on your desktop. Or for late-breaking updates, check the 
OfficeJet Pro website at the following address:

 http://www.hp.com/go/officejet-pro

Conventions Used
Throughout this Guide, we use specific conventions to help you 
quickly identify information:

boldface Bold typeface identifies a specific button name or 
command you need to enter.

CAUTION The Caution label calls attention to an operating 
procedure, practice, or the like, which, if not 
correctly performed or adhered to, could result in 
damage to or destruction of part or all of the product 
or your data. Do not proceed beyond a Caution label 
until you fully understand and have met the indicated 
conditions.

NOTE The Note label precedes information you need to 
know before you continue reading or performing a 
procedure.

“quotation marks” Information enclosed in quotation marks identifies 
the exact message that appears on the front panel 
display or your computer screen.

TIP The Tip label precedes helpful hints and 
recommendations.

WARNING The Warning label calls attention to a procedure, 
practice, or the like, which, if not correctly 
performed or adhered to, could result in personal 
injury. Do not proceed beyond a Warning label until 
you fully understand and have met the indicated 
conditions.
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Setting Up Your New 
HP OfficeJet Pro 2
This chapter presents recommendations for placement of your 
HP OfficeJet Pro and presents the eight simple steps for unpacking and 
setting up your HP OfficeJet Pro. Be sure to perform the steps in the 
order listed.

Choosing a Location and Environment for Your OfficeJet Pro
◆ Use your OfficeJet Pro only within normal office temperature and 

humidity ranges. The recommended range is 59o–95oF 
(15o–35oC) and 20%–80% humidity ranges.

◆ Avoid direct sunlight or locations where a quick change in 
temperature might cause condensation inside the machine.

◆ Make sure the location is well ventilated. Dust, gases, or fumes 
(such as ammonia or paint thinner) can damage the machine.

◆ Choose a site that is level, flat, and stable. The OfficeJet Pro will 
vibrate and needs to be on a sturdy surface.

◆ Be sure a grounded outlet is nearby and easily accessible.

◆ To ensure that you can open the automatic document feeder all the 
way, make sure to place your OfficeJet Pro at least 9 in. (230 mm) 
from the wall.
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Before You Start
Before you start setting up your HP OfficeJet Pro:

◆ Have this User’s Guide and installation CD-ROMs ready.

◆ If you will be installing WinFax PRO, have your Windows 95/98 
CD-ROM or installation diskettes available.

Direct Connection
The HP OfficeJet Pro must be connected directly to your computer’s 
parallel port. Do not use a switch box or the pass-through port of 
another parallel port product such as a scanner, tape drive, Zip™ drive, 
or CD-ROM drive.

CAUTION Connecting your HP OfficeJet Pro to a switch box or the pass-through port 
of another parallel product can cause erratic behavior of both products and 
the possible loss of information.
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Parallel Port Mode/Type
In order to scan using your HP OfficeJet Pro, you must have your 
computer’s parallel port set to one of the following modes:

You can determine the mode of your computer’s parallel port. Most 
computers have a Setup, CMOS, Hardware Configuration, or other 
screen that can be accessed during the boot process. This screen 
shows your computer’s current settings, including parallel port mode.

To learn more about changing the parallel port mode in your 
computer, consult the User’s Guide that came with your computer or 
read the ECP document that will be automatically installed in your 
HP OfficeJet Pro 1170C Series program folder when you install your 
software.

ECP (Extended 
Capabilities Port)

Available in recently manufactured computers. 
This mode ensures the fastest scanning speed. 
Note: Your computer may have ECP mode, but 
it may not be turned on.

Bi-Directional Allows communication back and forth between 
your computer and the OfficeJet Pro. Scanning 
will be slower than with ECP mode.
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Eight Easy Steps to Set Up Your HP OfficeJet Pro
To set up your HP OfficeJet Pro properly, follow the eight easy steps 
in the order shown below.

Step 1 — Unpack Your HP OfficeJet Pro
1 Remove the cardboard tray containing the accessory items.

2 Rest the box on its side, and pull out your HP OfficeJet Pro.

3 Remove the packing material and the orange packing tape from 
the outside of the product.

TIP Save the packaging materials in case you ever move or 
ship your HP Office Jet Pro.

4 Remove the two yellow/orange plastic inserts from the print tray 
by pulling up and toward the center of the product.
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5 Verify that the following items are included with your 
HP OfficeJet Pro:

a front-panel overlay (has text on it)

b this User’s Guide

c CD-ROM disks

d one black and one tri-color print cartridge

e power cord

f IEEE-1284 parallel printer cable

If any of the items are missing or damaged, contact the dealer from 
whom you purchased your HP OfficeJet Pro.

a

bc

de

f
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Step 2 — Attach the Front Panel Overlay
1 Align the front panel overlay with the front panel buttons. 

2 Push straight down firmly on both ends and the middle to snap the 
overlay into place.
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Step 3 — Unlock Your HP OfficeJet Pro
The scanner lock is under the front panel. 

Unlock the scanner by twisting the green knob (lever) under the front 
panel, toward the back of your HP OfficeJet Pro, until it stops. The 
knob (lever) only turns one way.

NOTE Leave the scanner unlocked unless you need to move your HP OfficeJet Pro. 
Locking the scanner protects it during moving. Refer to “Prepare Your 
HP OfficeJet Pro for Shipment” on 14-3 for locking instructions.
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Step 4 — Load Paper Into Your HP OfficeJet Pro
1 Remove the yellow/orange shipping inserts from the paper tray, if 

you have not already done so.

2 Slide the paper width and length adjusters to their outermost 
positions.

3 Insert up to 150 sheets of paper [approximately a 3/4 in. (19 mm) 
stack of paper] into the bottom (IN) tray, print side down, until it 
stops.

NOTE The output tray (top tray) can hold a maximum of 50 sheets. If you are making 
more than 50 copies, remove the excess copies from the output tray. If you do 
not, the excess copies may either fall off the tray or cause a paper jam.



HP OfficeJet Pro User’s Guide 2-9

4 Slide the paper width and length adjusters in until they stop at the 
edges of the paper.

See “Tips on Loading Paper in the Paper Tray” on 7-4 for information 
on loading specific paper types.
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Step 5 — Insert the Color and Black Print Cartridges
1 Lift the document cover, open the print cartridge access cover, and 

remove the yellow/orange shipping insert from the inside of the 
cartridge cradles. 

TIP Keep and store the shipping insert and other packing 
materials in case you ever need to move or ship your 
OfficeJet Pro.

NOTE Use the print cartridge access cover to prop open the document cover while 
you insert the print cartridges. 

2 Lift up both print cartridge latches.
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3 Remove the tri-color print cartridge (the thicker one) from its 
package and, being careful to touch only the black plastic, gently 
remove both the green pull tab and blue tape covering the 
nozzles.

CAUTION Be careful not to touch the gold-colored contacts.

4 Push the tri-color print cartridge firmly down into the cradle on 
the left, and close the cartridge latch.

5 Repeat steps 3 and 4 to install the black print cartridge into the 
cradle on the right.

6 Close the print cartridge access cover.

NOTE Both print cartridges must be correctly installed (with the green tab and blue 
tape removed) for your HP OfficeJet Pro to work.

tri-color print cartridge, 
part number C1823A

black print cartridge, 
part number C51645A
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Step 6 — Connect the Cable and Power Cord

NOTE Use the cable that was shipped with your product. It is a special IEEE-1284 
parallel cable that is necessary for the proper functioning of your 
HP OfficeJet Pro. If you choose to buy a longer cable, make sure it is an 
IEEE-1284 compliant parallel cable.

1 Connect the printer cable to HP OfficeJet Pro, snapping both clips 
into the notches. (The connector is located on the left side toward 
the back of the product.)

2 Plug the other end of the cable into your computer’s parallel port, 
and tighten the screws. 

CAUTION Do not connect your HP OfficeJet Pro to a switch box or the pass-through 
port of another parallel product, such as a scanner, tape drive, Zip™ drive, 
or CD-ROM drive. Doing so can cause erratic behavior of both products 
and the possible loss of information.
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The HP OfficeJet Pro comes with the power cord for the country to 
which it is shipped. If the plug on your power cord does not look 
familiar, contact your dealer or local HP Sales and Support Office.

WARNING In case there is an emergency and you need to shut off power to the 
HP OfficeJet Pro, choose an outlet that is easy for everyone to access.   

Power is present in the product even if the white button in the lower right front 
corner of the OfficeJet Pro has been turned off. To completely shut off power, 
you must disconnect the power cord.

Be sure to use the power cord with a properly grounded outlet to avoid 
electric shock.

NOTE Do not turn on your HP OfficeJet Pro yet!
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Step 7 — Install the Software

NOTE Do not turn on your HP OfficeJet Pro yet!

Now you need to install software so that the HP OfficeJet Pro can work 
with your computer. 

HP Software
1 Turn on or reboot your computer.

If you see the following screen, press the Esc key on your 
keyboard to close the “New Hardware Found” dialog. 

2 Start the installation by doing one of the following:

◆ Insert CD-ROM #1 into your computer’s CD-ROM drive. The 
software installation setup should start automatically (in less 
than a minute).

◆ If the software installation does not start automatically, from 
the Task bar, select the Start menu, and select Run. Enter 
z:\setup (substitute your CD-ROM drive letter for the “z”). 

The “Welcome” screen appears. Click Next>.
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3 The HP License Agreement is displayed. Click Yes to continue.

4 A dialog appears, instructing you to turn on your 
HP OfficeJet Pro.

5 Turn on your HP OfficeJet Pro now, by pressing the white button 
in the lower right front corner of the product, and click OK . 
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6 The following screen appears.

NOTE You must install both the printing and scanning software in order to scan. 

HP FontSmart comes with TrueType fonts and allows you to easily 
install and remove other fonts on your system. 

Click Browse… to select a different destination folder for the 
HP OfficeJet Pro software. Click Next> to continue. 
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7 A “Testing Device Connection” message is displayed while the 
installation program tests the cable connection between your 
computer and the HP OfficeJet Pro. 

If the bi-directional communications test fails, you will need to 
set the front panel language and page size manually, following 
the instructions on page 3-9. The communications problem must 
be resolved before you will be able to scan. 

After installing your software, refer to “Messages on Your PC, 
Cable Test Failed” under Troubleshooting in the 1170C Series 
Toolbox on your Windows desktop.   
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Product Tour
8 Next, you will be invited to take the HP OfficeJet Pro 1170C 

Series Product Tour.

The Product Tour is a 3–5 minute overview of the capabilities of 
your HP OfficeJet Pro. We recommend that you take the Tour 
before using the product for the first time. Click Next> to 
continue.

Insert CD-ROM#2, as prompted, and click OK  to take the Tour. 

At the end of the Tour (or at any point during the Tour), click the 
exit tour button at the top of the screen to exit the Tour and 
continue installing your software.

At this point, you have finished installing the HP software and can 
print and scan with your OfficeJet Pro.
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Additional Software
9 After you have completed the Tour, the “Install Software” dialog 

box appears. These software packages from Hewlett-Packard 
partners will enhance the capabilities of your OfficeJet Pro.

Click to put a checkmark next to the software product you want 
to install. 

◆ Caere Omnipage LE allows you to scan text into a format you 
can edit with your word processor.

◆ Imaging for the Internet allows you to view and print 
FlashPix® images off the Internet. If you do not have 
Internet access, do not install this software (click the 
checkmark off).

◆ Adobe PhotoDeluxe allows you to edit the images you scan.

◆ Symantec WinFax PRO allows you to send faxes using the 
fax modem in your PC and your OfficeJet Pro. If you do not 
have a fax modem, do not install this software (click the 
checkmark off).

NOTE Have your Windows 95/98 installation CD-ROM or installation diskettes 
available if you are installing Symantec WinFax PRO.
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Installing Caere OmniPage Limited Edition Software
10 If you install Caere OmniPage, follow the directions on the screen. 

When you see the following screen, be sure to select 
HP OfficeJet Pro PictureScan.

Installing HP Imaging for the Internet Software
11 If you are installing Imaging for the Internet, follow the directions 

on the screen. 

An Imaging for the Internet User Guide will be installed in the 
Imaging for Internet program folder, along with a README file. 
Do not view the README now; view it later, after you finish 
setting up your OfficeJet Pro.

Installing Adobe PhotoDeluxe Software
12 If you are installing Adobe PhotoDeluxe, follow the directions on 

the screen. We recommend the “Typical” installation. 

Microsoft Internet Explorer will be installed as part of the process.

NOTE If Adobe PhotoDeluxe asks to install Microsoft Internet Explorer, installing it 
will not change your default Web Browser.
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Installing Symantec WinFax PRO Software
13 If you are installing Symantec WinFax PRO, insert the Symantec 

WinFax PRO CD-ROM now, and click OK . Then follow the 
instructions on the screen.

a When you see this screen, enter your fax number and other 
dialing information as necessary. Click the Help button if 
you are not sure what to enter.

b When you see this screen, enter your name or your fax 
number in the CSID field.
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c If you see the following screen (you might not), insert your 
Windows 95/98 installation CD-ROM or diskettes. (If you do 
not have Windows 95/98 CD or diskettes, but the 
Windows 95/98 Setup files are on your hard drive, go to 
step 1).

1) Using either the Explorer or the Browse CD button, go 
to the Win 95/98 directory. The dialog box should tell 
you the exact directory and file it is looking for.

2) When you are asked if you want to set WinFax PRO as 
your default printer, be sure to answer No.

3) When you see a message similar to: “Could not open the 
file names: ‘Z:\WINFAX\WINFAX80\DISK.ID’” 
remove your Windows 95/98 CD, reinsert your 
WinFax PRO CD, and click Retry.

IMPORTANT If you do not have the Windows 95/98 setup files and cannot install 
these files, WinFax PRO will not work properly. You must reinstall 
WinFax PRO after you have located your Windows 95/98 software.
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d When you see the following screen, if you do not have a 
voice modem, uncheck TalkWorks by clicking the box.

When you have made all necessary entries, Symantec 
WinFax PRO will be installed.

14 Next, you will be prompted to restart your computer. You must 
reboot your computer before you can use the HP OfficeJet Pro. 
Click Finish. 

The first time you restart your computer after installing the 
HP OfficeJet Pro, you will be invited to register your product 
electronically. The information you provide to HP is confidential 
and is used to help us improve our products. And, when you 
register electronically, we install a free gift as our way of saying 
thank you! 
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Step 8 — Align Your Tri-Color and Black Print Cartridges
Before you start using your HP OfficeJet Pro, you need to align the 
tri-color and black print cartridges to ensure the best copy and print 
quality. 

When you turn on your HP OfficeJet Pro for the first time, you will see 
the message “Initializing,” followed by the message “Press Resume to 
Align Cartridges” on the front panel display.

NOTE If the message is not in your language, you will need to change the front panel 
language before proceeding with the next step. Go to page 3-9 for instructions 
on how to change the language.

1 Press the Select/Resume button. 

The OfficeJet Pro prints a page with two sets of paired lines on it. 
A set of numbered, horizontal lines appears at the top of the page, 
and a set of vertical lines, each with a unique letter, appears at the 
bottom of the page.

The mid-range number for horizontal alignment appears on the 
front panel display.
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2 Look closely at the set of horizontal bars, and determine which 
set of black and color lines is aligned the best.

3 Select the number on the front panel display that represents the 
best horizontal alignment pattern, and press Select/Resume.

If necessary, use the Plus (+) and Minus (–) buttons on the front 
panel to change the number on the display.

The mid-range letter for vertical alignment appears on the front 
panel display.

4 Now look closely at the set of vertical bars and determine which 
set lines up the best.

5 Select the letter that represents the best vertical alignment on the 
page and press Select/Resume.

If necessary, use the Plus (+) and Minus (–) buttons on the front 
panel to change the letter on the display.

6 The HP OfficeJet Pro then prints another page to confirm that the 
print cartridges are correctly aligned. 

7 Match the alignment in Sample 2 to the alignment in Sample 1. 

8 If the lines are straight, the Align Cartridges procedure is 
complete.

If the lines are not straight, you may want to repeat the Align 
Cartridges procedure. To do this, press the Menu button until the 
message “Align Cartridges” is displayed, press Select/Resume, 
and then repeat steps 2–6.

Congratulations! You have finished setting up your 
HP OfficeJet Pro. Now you are ready to start using it.



2-26 Setting Up Your New HP OfficeJet Pro



HP OfficeJet Pro User’s Guide  3-1

Copying 3
This chapter explains how to make copies and how to use the special 
copying features of the HP OfficeJet Pro. It also explains how to use 
other features on the front panel and special considerations of the 
automatic document feeder. 

NOTE The scanner light remains on for approximately 12 hours after you turn on the 
HP OfficeJet Pro or make the first copy of the day. This keeps the bulb warm 
for optimal performance. The bulb uses very little power. After 12 hours, the 
OfficeJet Pro turns off the scanner bulb to save energy, and displays a “Power 
Save On” message. When you are ready to use the OfficeJet Pro again, just 
press any button on the front panel.
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How to Make Copies
1 If it is not already on, turn on the HP OfficeJet Pro by pressing the 

white button on the lower right front corner of the product.

2 Manually (on the copy glass): Lift the document cover, place 
the original face down on the glass along the two green borders, 
and close the document cover. 

Put the long edge of your original along the longer green border. 

NOTE Be sure to place all originals, including small photographs, in the corner along 
the two green borders. Some features of the HP OfficeJet Pro look for items 
specifically in that corner.

Using the automatic document feeder: Load the original(s) 
with the printed-side facing back in the document feeder, with the 
top of the document to the right. Adjust the page guide to the 
length of the original(s). 
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When the originals are in place, the phrase “Document Loaded” 
appears briefly on the display, and lights flash. 

NOTE Refer to “Automatic Document Feeder Requirements” on page 7-5 for 
information on the types of paper you can use in the document feeder.

3 If you are making more than one copy, specify the number of 
copies to make.

4 If desired, adjust the way your copy will look using the Copy 
Quality, Reduce/Enlarge, Lighter/Darker, and Color Intensity 
buttons. See “Controlling How Copies Will Look” later in this 
chapter for details.

5 Start copying:

◆ Press the Black button to make a black and white copy.

◆ Press the Color button to make a color copy.

Controlling How Copies Will Look
You can change the default copy settings to produce copies that look 
the way you want them to. 

NOTE There is a small margin around the edge of paper that the HP OfficeJet Pro 
cannot copy onto. See “Copy Margins” on 15-3 for details.

This section explains how to use the following settings and options:

◆ Number of copies

◆ Scan To Fax

◆ Copy quality



3-4 Copying

◆ Reduce/enlarge features

◆ Paper types

◆ Lighter/darker

◆ Color intensity

◆ Text enhancement (TE)

◆ Enhance light colors (ELC)

◆ Copy paper size

◆ Set defaults

NOTE The copy settings are reset to their default settings two minutes after each 
copy job is complete.

TIP If you consistently use front panel settings other than the default, 
consider establishing those settings as your new defaults. See “Set 
Defaults” on 3-10 for more information.

Number of Copies
To specify the number of copies, when “1 Copy” or “x Copies” is 
displayed on the front panel, press the Plus (+) or Minus (–) button 
until the number of copies you want to make is displayed. 

Scan To Fax
When you press the Scan To Fax button, the HP OfficeJet Pro scans the 
original you have placed on the scanner glass or in the automatic 
document feeder, and launches Symantec WinFax PRO. For 
information on using this feature, see page 6-1.

Copy Quality
The Copy Quality button changes the speed and quality of the copies 
you make. You can choose from the following three copy settings: 

◆ Best produces the highest copy quality for all paper and eliminates 
the banding (striping) effect that sometimes occurs in solid areas. 
The Best setting copies more slowly than the Normal setting. 

◆ Normal delivers high-quality output and is the recommended 
setting for most of your copying. Normal is the default copy 
quality setting for most paper types, and is faster than Best.

◆ Fast copies faster than the Normal setting, and the text is of 
comparable quality. Using Fast also cuts down on the frequency of 
replacing your print cartridges because it uses less ink. 
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To change the Copy Quality setting, press the Copy Quality button, 
the small button directly beneath the three quality settings (Best, 
Normal, Fast), until the light next to the copy quality setting you want 
to use is lit.

Reduce/Enlarge Options
Using the HP OfficeJet Pro’s digital Reduce/Enlarge features, you 
can quickly and easily reduce or enlarge images to the size you want. 

NOTE Some Reduce/Enlarge features let you specify the exact percent reduction 
or enlargement you want to use. The Minus/Plus (– +) signs next to the 
feature name let you know whether this option is available. Press the 
Minus (–) or Plus (+) button once to change the percentage by 1. Hold down 
the Minus (–) or Plus (+) button to change the percentage in increments of 5.

◆ Normal 100% makes a copy that is the same size as your original.

◆ Entire 91% reduces your copy to ensure that all the edges are 
copied.

◆ Auto Fit pre-scans the original to determine where its edges are. 
Auto Fit then reduces or enlarges the original to fit on the paper 
you are copying onto.

When enlarging, Auto Fit increases the size of the copy to the 
largest size that will fit on the page without distorting the image, 
and centers the image on the page.

NOTE Use Auto Fit or Entire 91% to slightly reduce your original and ensure that 
you copy the entire page. Entire 91% is a faster solution, because it uses a 
fixed percentage to make the copy—no pre-scan is needed to calculate the 
size of the original. Auto Fit is an easy solution—the Auto Fit feature 
calculates the reduction percentage for you, and all your copies will be the 
same size.

◆ Custom 100% (– +) lets you specify (using the plus or minus 
buttons) the exact reduction or enlargement percentage to use. 
You can specify any percentage between 25% and 400%.
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◆ Poster 400% (– +) determines how to divide up the original image 
and enlarge each part to end up with an image that is up to 400% 
larger than your original. You can specify a different total 
enlargement percentage using the Minus (–) or Plus (+) buttons. A 
poster may be created using up to 25 sheets of paper (5 sheets wide 
and 5 sheets long).

For example, you can use Poster to create posters of your work to 
display in your office or store. Use HP Premium Photo Paper for a 
glossy, near-photo-quality look.

NOTE There is a minimum 1/4-inch overlap on all pages of the poster. This ensures 
that key elements on the page do not get cut off, and makes it easy for you to 
paste the pages of the poster together.

◆ Clone 100% (– +) fits as many copies of the original as will fit on 
one sheet of the paper you are using. You can specify a reduction 
or enlargement using the Minus (–) or Plus (+) buttons. 

For example, you can use Clone to make extra copies of special 
photographs for family and friends. For glossy, near-photo-quality 
copies, use HP Premium Photo Paper.

◆ Mirror 100% (– +) reverses the image of your original and makes 
a copy based on the percent reduction/enlargement you specify. 

You can use Mirror to copy favorite photos or images onto 
HP Iron-On T-Shirt Transfers. Then iron the image to make 
custom t-shirts, banners, and flags. You can also use Mirror to 
copy presentation materials onto HP Premium Transparency film. 
Then, when you flip each film over to make your presentation, you 
can write on it and erase, without worrying about smearing the ink.

NOTE When you select Iron-On as the paper type on the front panel, the 
HP OfficeJet Pro automatically selects Mirror as the Reduce/Enlarge setting.

To change Reduce/Enlarge settings:

1 Press the Reduce/Enlarge button repeatedly, until the setting you 
want is displayed. 

2 If the feature you are using allows, press the Plus (+) or Minus (–) 
button to change the reduce/enlarge percentage.

3 Press the Select/Resume button to select the new reduce/enlarge 
setting, or press the Clear/Stop button to cancel.
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Paper Types
The Paper Type you select affects how the HP OfficeJet Pro makes 
copies. It is important to select the appropriate Paper Type setting for 
the kind of paper you are copying onto. Review the table on page 7-3 
for more information.

To change Paper Type:

1 Press the Paper Type button repeatedly to scroll through the list 
of available paper types.

2 When the paper type you are using is listed, press 
Select/Resume to choose it. 

Lighter/Darker
Use the Lighter/Darker button to adjust the lightness and darkness of 
the copies you make.

To make copies Lighter or Darker:

1 Press the Lighter/Darker  button. The range of 
lightness/darkness values appears on a scale on the display.

2 To make your copy darker, press the Plus (+) button. The dot 
moves to the right. 

To make your copy lighter, press the Minus (–) button. The dot 
moves to the left.

3 Press Select/Resume to confirm your selection.

Color Intensity
Use the Color Intensity feature to make the colors on your copy more 
vivid or more subtle. 

To change Color Intensity:

1 Press the Color Intensity  button. The range of color intensity 
values appears on a scale on the display.

2 To produce copies with more intense or vivid colors, press the 
Plus (+) button. The round dot moves to the right on the scale. 

To produce copies with paler, more subtle colors, press the 
Minus (–) button. The round dot moves to the left on the scale.

3 Press Select/Resume to choose the new color intensity setting.
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TE (Text Enhancement)
TE sharpens the edges of black text. It is turned on by default and 
should, in most situations, be left on. However, turn TE off if:

◆ Large, black typefaces look splotchy (not smooth).

◆ Horizontal grainy or white bands appear in light- to medium-gray 
areas.

◆ Thin, colored objects or lines contain black sections.

NOTE TE is automatically turned off when Photo Paper is selected.

To turn TE On/Off:

1 Press the Menu button until “TE” appears on the front panel 
display.

2 Press the Plus (+) and Minus (–) buttons to switch between ❍ (off) 
and ● (on). 

3 Press Select/Resume to confirm your selection.

ELC (Enhance Light Colors)
Use the Enhance Light Colors (ELC) setting to enhance light-color 
backgrounds in documents, such as maps, photos, and invoices, so the 
background is included on the copy. The ELC feature improves the 
appearance of very pale colors. Turn on ELC if pale colors are copying 
as white.

To change the ELC setting:

1 Press the Menu button repeatedly until ELC appears on the front 
panel display. 

2 Press the Plus (+) and Minus (–) buttons to switch between ❍ (off) 
and ● (on). 

3 Press the Select/Resume button to confirm the change.
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Changing Other Front Panel Settings
This section explains how to use the following settings and options:

◆ Front panel language

◆ Copy paper size

◆ Set defaults

◆ Factory defaults

◆ Clear/Stop

Front Panel Language
You established the Front Panel Language when you first set up your 
HP OfficeJet Pro. To switch to a different language, follow these 
steps.

1 While holding down the Select/Resume button, press the Color 
Intensity button, then release both buttons. 

The current language is displayed.

2 Press the Plus (+) or Minus (–) button to scroll through the 
available languages until the language you need appears.

The following languages are available: English, Español, 
Deutsch, Français, Italiano, Nederlands, Dansk, Norsk, 
Portugués, Svenska, and Suomi.

3 Press Select/Resume to choose the displayed language.

4 You will be prompted to change Paper Size. See steps 3 and 4 in 
the next section.

Copy Paper Size
With your HP OfficeJet Pro, you can copy on either 
letter- (8.5 x 11 inches) or A4- (210 x 297 mm) sized paper. 

To change Copy Paper Size:

1 Press the Menu button repeatedly until you see “Copy Paper 
Size” on the front panel display. 

2 Press Select/Resume to view the current default paper size.

3 Press the Plus (+) or Minus (–) button to toggle between the two 
paper sizes.

4 Press Select/Resume when you see the paper size you want.
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Set Defaults
If you consistently use settings on the front panel other than the 
default, you can establish those setting as your new default.

NOTE The default setting is always indicated by a solid dot.

You can change default settings for all your front panel options. To 
establish new defaults, first set all options the way you want them to 
be. Then use the Set Defaults feature to save all the settings. 

Here is an example using Auto Fit.

1 Press the Reduce/Enlarge button repeatedly until “Auto Fit” is 
displayed. 

2 Press Select/Resume. (This step changes your regular 
Reduce/Enlarge setting from Normal 100% to Auto Fit.)

3 Press the Menu button until “Set Defaults” appears on the front 
panel display.

4 Press the Select/Resume button. The message “Current settings 
saved as defaults” is displayed. (This step saves the new 
setting—Auto Fit—as your default.)

Factory Defaults
You can return all the front panel settings to their factory defaults at 
one time.

To return to Factory Defaults:

1 Press the Menu button repeatedly until you see “Factory 
Defaults” on the front panel display.

2 Press Select/Resume.

The message “Returned to factory defaults” appears on the front 
panel display.

Clear/Stop
Use the Clear/Stop button to cancel copy settings you have specified 
or to stop copying.

◆ When you press the Clear/Stop button to cancel copy settings, 
they are reset to default settings.

◆ When you press the Clear/Stop button to stop copying, the phrase 
“Copy Cancelled” appears on the front panel display. After a few 
seconds, the HP OfficeJet Pro cancels the job.
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Using the Automatic Document Feeder (ADF)
With the automatic document feeder, you can feed up to 30 originals 
at a time. You can use letter-sized or A4-sized originals in the feeder. 
Here are some other tips:

◆ Always feed your originals with the printed-side facing back in 
the document feeder, and the top of the document to the right.

◆ Do not mix paper types or sizes in the ADF.

◆ Load only originals printed on 16–24 lb. paper in the document 
feeder. Originals on lighter or heavier paper will not feed 
correctly and may jam in the feeder.

◆ To prevent paper jams, use the ADF with plain paper or 
HP Premium InkJet paper only. 

◆ Do not use photo paper, transparency film, photos, labels, or 
envelopes in the document feeder.

◆ When you make more than one copy using the document feeder, 
you will need to collate the sets manually.

◆ For instructions on how to clear an automatic document feeder 
paper jam, see page 12-1.

◆ Do not load colored originals printed on a color laser printer.

◆ Slick-surfaced papers will jam in the ADF. A full-page color 
graphic printed on a color laser printer develops a slick surface.
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Printing 4
Using your HP OfficeJet Pro, you can print on many sizes and types of 
paper, such as letter-, A4-, and legal-sized paper. You can also print on 
envelopes, transparency film, labels, cards, and even custom-sized 
letterhead or stationery.

For more information on printing on these types of paper, see page 7-2.

Start Printing
1 If it is not already on, turn on HP OfficeJet Pro by pressing the 

white button located on the lower right front corner of the product.

NOTE The scanner light remains on for approximately 12 hours after you turn on the 
HP OfficeJet Pro or make the first copy of the day. This keeps the bulb warm 
for optimal performance. The light uses very little power. After 12 hours, the 
OfficeJet Pro turns off the scanner bulb to save energy, and displays a “Power 
Save On” message. When you are ready to use the OfficeJet Pro again, just 
press any button on the front panel.

2 Load up to 150 sheets of paper into the bottom (IN) tray of the 
HP OfficeJet Pro. For more detailed instructions on loading paper, 
see page 7-4.
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3 Change the print settings as necessary:

a From your software program’s File menu, select Print . You 
will see a dialog box similar to the one below. 

b Click the Properties button. The HP OfficeJet Pro 1170C 
Series print setup dialog box is displayed.

c Here is where you specify Paper Size, Paper Type, and Print 
Quality for the file you are printing. Make necessary 
adjustments, then click OK  to return to the Print dialog.

NOTE The settings you change here remain in effect while you are using the current 
program. To make your changes permanent, make them in the Control Panel 
Printers folder.
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TIP For detailed instructions on changing print settings, 
such as Paper Size and Orientation, see the 1170C 
Series Toolbox. For information on accessing help, see 
page 10-3.

4 When all setup options are set correctly, from your software 
program’s File menu, select Print .

Stop Printing
You can stop printing a file using either the HP OfficeJet Pro or 
Windows 95/98.

Stop a Print Job from the HP OfficeJet Pro
◆ Press the Clear/Stop button on the front panel to stop printing.

Stop a Print Job from Windows 95/98
1 On the taskbar, click Start, and then select Printers from the 

Settings menu.

2 Double-click the HP OfficeJet Pro 1170C Series icon.

3 From the list, select the document you want to cancel.

4 From the Document menu, select Cancel Printing.
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NOTE Most programs that were designed for Windows 95/98 use the 
Windows 95/98 print spooler. The above procedure will work to stop printing 
in these programs. If the procedure does not work, your program may not use 
the Windows 95/98 spooler (for example, PowerPoint in Microsoft Office 95 
and 97). If this happens, follow the instructions for canceling “Background 
Printing” in the on-line help for your program.
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Scanning 5
Using your HP OfficeJet Pro and the software programs that come 
with it, you can scan text and pictures and then make changes to them. 
This chapter highlights the methods you can use to scan text and 
pictures. 

For more information on scanning, including step-by-step instructions, 
refer to the OfficeJet Pro Scanning Tutorial. See page 10-2 for more 
information.

Scanning Methods
You can scan in several different ways.

While working in a word processing, spreadsheet, or presentation 
program:

◆ ScanPicture—Scan and import pictures while working in a word 
processing, spreadsheet, or presentation program.

◆ Acquire Text—Scan and import editable text using 
Caere OmniPage LE, while working in most word processing 
programs.

◆ TWAIN —Scan and import pictures while working in 
TWAIN-aware programs like Adobe PhotoShop.

Using a standalone program:

◆ HP PictureScan (Scan to a File)—Scan pictures using 
HP PictureScan, a program in your HP OfficeJet Pro 1170C Series 
folder, and save it as a graphics file.

◆ Caere OmniPage LE—Scan text using Caere OmniPage LE, a 
program in the Caere Applications folder, and save it as a text or 
document file.
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Using Scan To Fax and WinFax PRO:

◆ Scan To Fax—Launch WinFax PRO from the OfficeJet Pro front 
panel, and scan pictures or text into a fax to send. (See Chapter 6.)

◆ WinFax PRO—Scan pictures or text into a ready-to-send fax file. 
(See Chapter 6.)

Scanning Tips
◆ Never scan at a higher resolution or bit depth than you need. It 

does not improve the quality, and just takes up disk space.

◆ Photos typically are not high resolution, so scanning at a 
resolution greater than 100 dpi will not improve the quality of the 
scanned photo image.

◆ If you want higher resolution for your photos, use the 
OfficeJet Pro 300 dpi printer destination under the Options menu. 
Keep in mind that one full-page scan at that resolution can use as 
much as 24 MB of disk space. See the Scanning Tutorial for more 
information. 

◆ If you are scanning something to go on a web site or display 
screen, remember that most screens only display at 72 dpi.

◆ If you want to save an image in FlashPix (.fpx) format, launch 
Adobe PhotoDeluxe, and use the TWAIN feature to scan the 
image. Then save it as a .fpx file type.

Scanning While Working in a File

Scanning Using HP ScanPicture
With HP ScanPicture, you can scan pictures directly into the document 
you are working on. It is the easiest way for you to scan. Most 32-bit 
Windows 95/98 programs that allow cutting and pasting (for example, 
word processing programs, spreadsheets, and presentation packages) 
can use ScanPicture. 

ScanPicture is automatically listed on the File menu of many programs 
after you complete the HP OfficeJet Pro installation.

NOTE Microsoft Office 97 Users: If you installed Office 97 after installing your 
HP OfficeJet Pro software, you will need to run a special program to “turn on” 
this feature in your Office 97 programs. See “Installing the Office 97 Utility” on 
13-3 for more information.



HP OfficeJet Pro User’s Guide 5-3

To use ScanPicture:

1 Place the item you want to scan against the green borders on the 
scanner glass.

NOTE You cannot use the automatic document feeder with the ScanPicture option.

2 Place your cursor in the document where you want your scanned 
image to be placed, and select ScanPicture from the File menu.

3 A preview scan displays. The animated selection border shows 
the portion that will be scanned.

a To crop a square or rectangular-shaped image, click the 
square marquee button and pull the border to where you 
want it. 

b To crop an irregularly shaped image, click the lasso button 
and draw around the area you want scanned.

TIP If you want to change the size of your scanned image, 
your final picture will look better if you change the size 
to the required dimensions before you import it into your 
document. To do this, click the Options button, and click 
the Rulers icon. Then specify the size you want the 
scanned image to be.

4 Click Accept.

The image you scanned is imported into your document.

Scanning Pictures in TWAIN-Aware Programs
TWAIN1 is an industry standard software/hardware interface that 
allows you to scan images directly into a software program using a 
menu command.

TWAIN is a part of many graphics programs, such as Adobe 
PhotoDeluxe. Scanning using TWAIN is similar to using 
HP’s ScanPicture. The specific procedure is different for each 
TWAIN-aware program. Here is an example of how the TWAIN 
feature works in Adobe PhotoDeluxe.

1. TWAIN is an acronym for Technology Without An Interesting Name.
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1 Open a file using Adobe PhotoDeluxe.

2 Place the item(s) you want to scan against the green borders on the 
scanner glass or in the automatic document feeder (ADF). If you 
are using the ADF, be sure to place the originals with the printed 
side facing back and to the right.

NOTE When you scan using the automatic document feeder, the entire image is 
scanned, without a preview scan. To change the size of the scanned image, 
you will need to edit it after it is saved.

3 Click Get Photo on the task list, then click the Get Photo tab. 

4 Click the Scanners icon. 

5 Enter a name for your image file, and click OK . 

The image file is placed in your “My Photos” directory.

6 To open the file, double-click its icon in the “My Photos” folder.

Scanning Text Using Acquire Text
If you installed Caere OmniPage LE, a new menu item called Acquire 
Text will now be available in the File menu of many word processing 
programs. You can use this feature to scan text directly into your word 
processing files for editing.

NOTE If Acquire Text does not appear on your File menu, check to make sure that 
“OCR Aware” is selected in Caere OmniPage LE. To do this, launch Caere 
OmniPage LE, and select OCR Aware from the Tools menu. Refer to the 
Caere OmniPage LE on-line help for more information.

To use the Acquire Text feature:

1 Create or open a file using your word processing program.

2 Place the document you want to scan against the green borders on 
the scanner glass or in the automatic document feeder (ADF). If 
you are using the ADF, be sure to place the originals with the 
printed side facing back and the top to the right.

3 Select Acquire Text from the File menu. 

NOTE The first time you use Caere’s OmniPage LE, a registration screen will display.
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4 Click Scan.

The pages will be scanned and imported into your file, ready for 
editing.

Scanning Using a Standalone Program

Scanning Pictures Using HP PictureScan
With HP PictureScan, you can scan pictures and save them in a new 
file. You will find PictureScan listed as 1. Scan in the 
HP OfficeJet Pro 1170C Series folder under your Start menu.

To scan using PictureScan:

1 Place the item(s) you want to scan against the green borders on 
the scanner glass or in the automatic document feeder (ADF). If 
you are using the ADF, be sure to place the originals with the 
printed side facing back and the top to the right.

NOTE When you scan using the automatic document feeder, the entire image is 
scanned, without a preview scan. To change the size of the scanned image, 
you will need to edit it after it is saved.

2 Select 1. Scan in the HP OfficeJet Pro 1170C Series folder.

3 Click Pictures, and then click Scan. 

A preview of the image displays. The animated selection border 
shows the portion that will be scanned.

a To crop a square or rectangular-shaped image, click the 
square marquee button and pull the border to where you 
want it. 

b To crop an irregularly shaped image, click the lasso button 
and draw around the area you want scanned.

4 Click Accept when you are satisfied with how the scanned image 
looks.

5 Enter a name for the image file, select a file type, and click Save.

See the on-line Scanning Tutorial for information on file types and 
file sizes.

NOTE For multiple pages, the images will be saved as name, name01, name02, 
and so forth, where “name” is the filename you entered.
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TIP If you want to save an image in FlashPix (.fpx) format, launch 
Adobe PhotoDeluxe, and use the TWAIN feature to scan the image. 
Then save it as a .fpx file type. See “Scanning Pictures in 
TWAIN-Aware Programs” on 5-3.

Scanning Text Using Caere OmniPage LE
To scan text and save it in a new text file:

1 Under the Start menu, select Programs and then select 
OmniPage Limited Edition from the Caere Applications folder.

2 From the File menu, select New Job to create a new file. 

3 In the Load Scanner window:

a Click Feeder if you are scanning using the automatic 
document feeder.

b Click Flatbed if you are scanning one item on the scanner 
glass.

NOTE If a page is loaded in the automatic document feeder, the Load Scanner 
window will not display.

4 Click Scan to start scanning.

Caere OmniPage LE scans the loaded images and imports them as 
separate pages in your new “Job” file.

5 After the page is scanned, click the OCR button.

Caere OmniPage LE processes the image and converts it into 
editable text.

NOTE If you are scanning multiple pages using the automatic document feeder, the 
next page will not be scanned unless you click the OCR button to convert the 
previous page.

6 Name your new file, and save it.
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Editing Your Scanned Pictures
You can edit your scanned pictures using the image editor software 
provided with your HP OfficeJet Pro. 

◆ If you used ScanPicture to place an image in a document, simply 
double-click the image to start Adobe PhotoDeluxe. After you 
have finished editing your picture, click the Exit & Return to 
HP ScanPicture button. The modified picture appears in your 
document.

◆ If you saved the scanned image as a graphics file, open the image 
using Adobe PhotoDeluxe, and then modify it as needed. 

NOTE For detailed information on using Adobe PhotoDeluxe, refer to its on-line 
help. 
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Communicating 6
This chapter explains how to scan and send it as a fax file attachment 
using the HP OfficeJet Pro and Symantec WinFax PRO. To scan and 
send e-mail, refer to the Symantec WinFax PRO on-line help.

Scanning Using WinFax PRO

Scanning Using Scan To Fax
With the OfficeJet Pro, you can scan a page (or multiple pages), 
automatically launch Symantec WinFax PRO, and include the scanned 
pages in the fax you send. 

To use Scan To Fax:

1 Place the item(s) you want to scan against the green borders on the 
scanner glass or in the automatic document feeder (ADF). If you 
are using the ADF, be sure to place the originals with the printed 
side facing back and the top to the right.

2 Press the Scan To Fax button on the front panel of your 
HP OfficeJet Pro.

The page (or pages) are scanned and included as separate pages in 
your fax. After all pages have been scanned, the Symantec WinFax 
PRO “Send Fax Wizard” window is displayed on your computer.

3 On your computer, enter destination information for your fax, and 
add a cover page, message, and attachments, if desired.

4 Press Finish to send the fax.
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Scanning Using Symantec WinFax PRO Standalone
1 Place the page(s) you want to scan against the green borders on the 

scanner glass or in the automatic document feeder (ADF). If you 
are using the ADF, place the originals with the printed side facing 
back and the top to the right.

2 On the taskbar, click Start, and from the Programs menu select 
WinFax PRO from the WinFax PRO directory.

The main Symantec WinFax PRO window appears.

3 From the Tools menu, select Scan, then select Scan and Send.

After all pages have been scanned, the Symantec WinFax PRO 
“Send Fax Wizard” window is displayed on your computer.

4 Enter destination information for your fax, and add a cover page 
and message, if desired.

5 Press Finish to send the fax.

NOTE For details on using other Symantec WinFax PRO features and options, refer 
to the Symantec WinFax PRO on-line help, or visit Symantec’s website at 
http://www.symantec.com.
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All About Paper 7
This chapter explains the paper types you can use when copying and 
printing. It also presents some tips on loading paper and transparency 
film, and specifies paper requirements for originals used in the 
automatic document feeder. 

For a current list of HP papers, visit our website:

http://www.hp.com/go/officejet-pro

HP Papers 
The HP OfficeJet Pro is designed to copy and print onto a variety of 
paper types and weights, including plain paper. Be sure that all paper 
is free of rips, dust, wrinkles, and curled or bent edges.

For highest quality results, use HP papers. 

◆ HP Bright White InkJet Paper delivers high-contrast colors and 
sharp text. It is opaque enough for two-sided color printing, with 
no show-through. It is ideal for newsletters, reports, proposals, and 
flyers.

◆ HP Premium Photo Paper is a high-quality, glossy-finish, 
photo-based inkjet paper. It looks and feels like a photograph and 
can be mounted under glass or in an album. HP Photo paper dries 
rapidly and resists fingerprints and smudges.

◆ HP Iron-On T-Shirt Transfers can be used to transfer your designs 
or photos (either by copying or printing) onto t-shirts, sweatshirts, 
and fabric crafts.

◆ HP Premium Transparency Film is designed to make your color 
presentations vivid and even more impressive. This film is easy to 
use and easy to handle and dries quickly without smudging.
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◆ HP Premium Heavyweight InkJet paper is matte-coated on both 
sides for double-sided copying. It is the perfect choice for 
near-photographic reproductions and business graphics for report 
covers, special presentations, brochures, mailers, and calendars.

◆ HP Premium InkJet Paper is the ultimate coated paper for 
high-resolution printing. A smooth-matte finish makes it ideal for 
your special documents. 

NOTE See page 7-5 for automatic document feeder paper requirements.

Paper Choices When Copying
You should copy only onto letter- and A4-sized papers.

Using the Right Front Panel Paper Type When Copying
The Paper Type you select determines how the HP OfficeJet Pro copies 
onto the paper you are using. Each time you load a different type of 
paper in the paper tray or document feeder, be sure to set the 
corresponding Paper Type on the front panel.

See “Paper Types” on page 3-7 for information about setting Paper 
Type on the front panel.

NOTE Front panel settings affect copying only. To select Paper Types for printing, 
see “Paper Choices When Printing” below.

For this Kind of Paper Select this Paper Type

Copier paper or letterhead Plain Paper

HP Bright White InkJet Paper Plain Paper

HP Premium Transparency Film Transparency

HP Premium Photo Paper Photo Paper

HP Premium InkJet Paper Premium InkJet

HP Premium Heavyweight InkJet Paper Premium InkJet

HP Iron-On T-Shirt Transfers Iron-On
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Paper Choices When Printing 
The HP OfficeJet Pro is designed to print on many sizes and types of 
paper, such as letter-, A4-, and legal-sized paper. You can also print 
on envelopes, labels, cards—even custom-sized letterhead or 
stationery.

Using the Right Print Settings in the OfficeJet Pro Print 
Properties Dialog
The Print Settings you choose in the Print Properties dialog tell the 
printer how to work with the specific paper you are using. It is 
important that you specify the correct Print Settings (see page 4-1 for 
details on setting and using Print Properties).

The Print Setting you choose automatically sets the optimal print 
quality for the paper you are using. 

NOTE If you are printing on special HP papers, the OfficeJet Pro automatically 
chooses the Best print quality to ensure the clearest, crispest results.

For this Kind of Paper Select this Paper Type

HP Bright White InkJet paper Plain Paper

Copier paper Plain Paper

Letterhead Plain Paper

HP Premium InkJet Paper HP Premium InkJet Paper

HP Premium Heavyweight InkJet 
paper

HP Premium InkJet Paper

HP Premium Photo paper HP Premium Photo Paper

HP Iron-On T-Shirt Transfers HP Iron-On — automatically selects 
Flip Horizontal

HP Premium Transparency Film HP Transparency

Labels Plain Paper — be sure to use letter- or 
A4-size labels designed for use in 
HP InkJet products, such as DeskJet 
Printers (like AveryTM InkJet labels)
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Tips on Loading Paper in the Paper Tray
◆ All paper: Load paper print-side down with the letterhead (or top 

of page) going into the tray first. Be sure paper is loaded fully 
forward in the paper tray.

◆ HP Premium InkJet Paper: Locate the gray arrow on the 
nonprinting side of the paper, and insert paper with the arrow side 
facing up.

◆ HP Premium Photo Paper: Load the shiny side facing down. 
Always load at least 5–10 sheets in the paper tray. You can place 
the photo paper sheets on top of plain paper in the paper tray.

◆ HP Premium Transparency Film: Insert the film so that the white 
transparency strip, with arrows and the HP logo, is on top and 
going into the tray first. 

◆ HP Iron-On T-Shirt Transfers: For best results, manually feed 
one sheet at a time, with the unprinted side facing down. Flatten 
the transfer sheet completely before using; do not load curled 
sheets. To prevent curling, keep transfer sheets sealed until just 
before printing.

Special Considerations When Using Transparency Film
◆ Load a maximum of 80 transparency sheets at a time.

◆ Be sure to specify “Transparency” as the Paper Type setting.

◆ Ink dries slower on film. Be sure to allow enough time for the ink 
to dry before using the transparency.

◆ If you are copying from a transparency (that is, your original is 
printed on transparency film), place a blank piece of paper over the 
transparency on the copier glass. 

NOTE We recommend using only HP Premium Transparency Film when copying or 
printing on transparencies. Other transparency film can jam in the 
OfficeJet Pro.
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Input Tray Requirements

Automatic Document Feeder Requirements
◆ Load a maximum of 30 originals at a time.

◆ Load only plain paper (white and color), letterhead, and 
HP Premium InkJet in the 16–24 lb (60–90 g/m2) range.

◆ Always insert originals with the printed-side facing back in the 
feeder and the top of the paper to the right.

◆ Do not start copying until the “Document loaded” message 
appears on the front panel display and you see the Copy Quality 
lights flash.

◆ Do not load colored originals printed on a color laser printer.

NOTE Do not load photos, paper sizes other than letter or A4, photo paper, 
transparency film, labels, or envelopes in the automatic document feeder. 
Doing so may cause a paper jam.
Slick-surfaced papers will jam in the ADF. A full-page color graphic printed 
on a color laser printer develops a slick surface.

Recommended Use Not Recommended
◆ 16- to 36-lb (60- to 135-g/m2) 

copier paper or letterhead
◆ Paper heavier than 36 lb (135 g/m2) 

or lighter than 16 lb (60 g/m2)

◆ HP Premium InkJet Paper ◆ Paper with cutouts or perforations

◆ HP Premium Photo Paper ◆ Photo paper other than 
HP Premium Photo

◆ HP Bright White InkJet Paper ◆ Transparency film other than 
HP Premium

◆ HP Premium Transparency Film◆ Any size paper other than Letter 
or A4

◆ Letter-, legal, or A4-size paper ◆ Heavyweight paper other than 
HP Premium

◆ HP Premium Heavyweight InkJet 
paper

◆ Multiple-part forms or label stock

◆ HP Iron-On T-Shirt Transfers

◆ Envelopes

◆ Labels

◆ Custom paper sizes
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Sharing the 
OfficeJet Pro Over a 
Network 8
This chapter explains how to set up the HP OfficeJet Pro and your 
computers for network printing and file sharing. 

IMPORTANT Contact your network administrator before setting up your 
OfficeJet Pro for file sharing. Your company may have security 
guidelines for you to follow.
Hewlett-Packard does not provide support for peer-to-peer networks, 
file sharing, and printing. Check your Windows Help system or 
Microsoft for assistance.

After this is done, all computers that are set up properly will be able to:

◆ Print to the HP OfficeJet Pro.

◆ Access files on the computer directly connected to the 
HP OfficeJet Pro.

NOTE Your computers must already be networked to use this procedure.

Setting Up for Peer-to-Peer Printing and File Sharing
To set up for peer-to-peer printing and file sharing, you will need to set 
up your “server” computer and “client” computers.

◆ A “Server” is the computer that is connected directly to the 
HP OfficeJet Pro using the supplied IEEE-1284 cable.

◆ A “Client” is another computer on your network that needs to be 
set up to print to the shared HP OfficeJet Pro 1170C Series.
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Setting Up the Server
1 Install the HP OfficeJet Pro 1170C Series software on the server, 

as described in Chapter 2 of this User’s Guide. 

2 Next, set up the server so that other computers on the network can 
print to the HP OfficeJet Pro and access files. 

NOTE See “Enabling file and printer sharing” and “Sharing your printer with other 
people” in Microsoft Windows 95/98 Help for detailed instructions.

3 Now, create a special folder that people using other computers on 
the network will be allowed to access. Name this folder 
appropriately, so that it is identified clearly as a shared folder (for 
example, “Share” or “Scanfiles”).

Setting Up Client Computers

Installing Printing Software
The HP OfficeJet Pro 1170C Series printing software must be installed 
on each “client” computer that will be printing to the HP OfficeJet Pro.

1 Run Setup.exe, from either the HP OfficeJet Pro 1170C Series 
CD-ROM #1 or wherever your network administrator installed the 
software. 

NOTE The CD may automatically run setup for you.

2 When you see the “Welcome” screen, click Next>.

3 When you see the “HP Software License Agreement” screen, click 
Yes.

4 When you are asked to “Turn on your HP OfficeJet Pro now...” 
click OK .

5 On the “Select HP Components” screen, click Scanning Files to 
remove the check mark. (You are not installing the scanning 
software on the client computer’s hard disk because the scanning 
software does not work over a network.) 

6 When the Communications Test fails, click Continue>.

7 When you see the “Results of Communication Test” dialog box, 
click Next>. 

8 Select a Model Number when you are prompted to do so. 
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9 When you are asked to take the Product Tour, click View the 
tour now to remove the check mark, and then click Next>. 

10 When you are asked to insert CD-ROM#2, click Cancel. 

11 Click Finish to restart the client computer. 

12 After your computer restarts, you will see the “Electronic 
Registration” screen. Click Never Register for the first screen 
and Yes in the second screen so the registration screen does not 
appear again.

Printing and font software is now installed on this client 
computer. 

13 Repeat this procedure for all client computers.

Redirecting Client Printing Software to the OfficeJet Pro
When the printing software is installed, printing is automatically 
directed to the “LPT1” port. It needs to be redirected for all client 
computers that will print to the HP OfficeJet Pro.

1 On a client computer, open the Windows 95/98 “Printer” folder 
(instructions for doing this are available in Windows 95/98 Help). 

2 Select the HP OfficeJet Pro 1170C Series icon by clicking on 
it once. 

3 From the File menu, select Properties. 

4 In the “Properties” window, click the Details tab, then click the 
Add Port  button.
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5 In the “Add Port” dialog, click the Browse… button to see a list 
of networked printers.

6 In the “Browse for Printer” dialog, click on the OfficeJet Pro, then 
click OK .

7 Click OK  to select the network path to the printer.
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8 Click OK  again to enable printing to the redirected port. 

9 To print to the shared HP OfficeJet Pro 1170C Series from your 
software programs, select it using each program’s “Print” dialog.

How to Share Files Across a Peer-to-Peer Network
1 Follow the “Opening a shared folder” procedure in 

Windows 95/98 Help to access the file or folder you need.

2 Copy the file from the shared folder to your computer.
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Maintaining Your 
HP OfficeJet Pro 9
With minimal maintenance you can keep your HP OfficeJet Pro in top 
working condition. Perform the following maintenance procedures as 
necessary.

Cleaning the Exterior Case
Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off 
the case. The interior of the HP OfficeJet Pro does not require 
cleaning. Keep fluids away from the interior of the HP OfficeJet Pro.

Cleaning the Glass
Dirty copier glass (fingerprints, smudges, etc.) slows down copying 
and scanning performance by as much as half a minute! This is 
because the scanner is actually processing the smudges on the glass. 
Be sure to keep the glass clean and free from dust, smudges, and 
fingerprints.

WARNING Turn off the HP OfficeJet Pro and unplug the power cord before cleaning. 
Even though the HP OfficeJet Pro is off, power is still being supplied if the 
power cord is plugged in.
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To clean the glass:

1 Turn off the HP OfficeJet Pro, remove the power cord, and then 
raise the document cover.

2 Clean the glass with a soft cloth or sponge slightly moistened with 
warm water and a mild soap or detergent. You may also use glass 
cleaner.

CAUTION Do not use abrasives, acetone, benzene, or carbon tetrachloride on the 
glass; these can damage the glass. Do not place liquids directly on the 
glass. They may seep under it and damage your HP OfficeJet Pro.

3 Rinse the soft cloth or sponge with clean water, wring out excess 
water, and wipe the remaining soap or detergent off the glass.

4 Dry the glass with a chamois or cellulose sponge to prevent 
spotting. If soap or detergent does not clean the glass sufficiently, 
you can use isopropyl alcohol as a cleaning agent.
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Getting Help 10
Your OfficeJet Pro includes several resources to help you get started 
and use the product to full advantage. This chapter describes the types 
of help available.

HP Multimedia Product Tour 
The on-line tour for the OfficeJet Pro gives you a brief introduction to 
the all-in-one product and its capabilities.

You can run the Tour either from the HP OfficeJet Pro 1170C Series 
folder or from the 1170C Series Toolbox.
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HP Scanning Tutorial
The OfficeJet Pro scanning tutorial answers your questions about 
scanning—from the basics (“What is scanning anyway?”) to the more 
advanced (“How do I change resolution?”). 

The Tutorial also gives you step-by-step instructions for scanning, and 
gives you important tips on using the HP OfficeJet Pro to its full 
potential.

TIP The Scanning Tutorial is designed to be used as both an 
introduction to scanning and a reference tool. You do not have to 
go through the Tutorial from start to finish; you can end it at any 
time.

You can run the Tutorial either from the HP OfficeJet Pro 1170C 
Series folder or from the 1170C Series Toolbox.

On-Line Help
On-line help is available for the OfficeJet Pro and the programs that 
come with it. 

Caere OmniPage LE, Adobe PhotoDeluxe, and Symantec 
WinFax PRO
To access on-line help in Caere OmniPage LE, Adobe PhotoDeluxe, 
and Symantec WinFax PRO, just select an option from the Help menu 
while working in these programs. Symantec WinFax PRO also 
features an on-line tour/tutorial, which is also very helpful. 
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HP PictureScan Help
The main HP PictureScan window includes a Help button at the 
bottom of the screen. Click it to view detailed information on using 
PictureScan.

1170C Series Toolbox
Your 1170C Series Toolbox help presents detailed procedures for 
many tasks you will perform with your HP OfficeJet Pro. The 
Toolbox help also includes troubleshooting information. When 
problems occur, look for a description of the particular symptoms you 
are experiencing. You will find details on how to fix it. 

For help on 
scanning using 
PictureScan, click 
here.
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You access this help from the HP OfficeJet Pro 1170C Series folder, or 
by double-clicking the 1170C Series Toolbox icon on your desktop. 
You can also select HP OfficeJet Pro Help from the Help menu of 
many of your word processing, spreadsheet, or presentation programs.

The How Do I? tab features help for many tasks you perform every 
day. It includes a complete copy of your HP Limited Warranty, 
information about HP papers, and quick access to the on-line tour and 
tutorial.

If you are having trouble copying, printing, or scanning, go the toolbox 
Troubleshooting tab. It includes help for printing, scanning, and 
copying problems, and lists messages you may see as you work.

Using the Product Services tab, you can clean and align print 
cartridges, print a self-test page, test the communication between your 
HP OfficeJet Pro and your computer, test the scanner, and calibrate 
your screen.
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Support Services 11
This chapter explains how to get support for the OfficeJet Pro 1170C 
Series and the other software programs included with your all-in-one 
product.

Get Help from HP
If you are unable to find the answer you need in this book or in on-line 
help, you can contact one of the HP support services listed in the 
following pages.

Some support services are available only in the U.S. and Canada, while 
others are available in many countries worldwide. If a support service 
number is not listed for your country, contact your nearest authorized 
HP dealer for help.

On-Line Services

Internet
For the most up-to-date product information, driver support, and 
answers to frequently asked questions, visit the Hewlett-Packard 
OfficeJet Pro World Wide Web home page at the following address: 

http://www.hp.com/go/officejet-pro

This website is updated whenever information and support contact 
numbers change.

HP Distribution Center
To order current printer and scanner drivers in the U.S., dial 
1-888-HP DISKS (1-888-473-4757).
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In Europe, dial one of the following numbers:

In Latin America, drivers are available in English, Spanish, and 
Portuguese. Dial one of the following numbers: 

In Asia and Australia, dial one of the following numbers:

HP FIRST
Call HP FIRST to request information to be faxed directly to you. 
Hewlett-Packard offers this service free of charge. To use HP FIRST, 
you need a touch-tone phone, and a 9600-baud, Group 3 facsimile 
machine so you can receive the information. 

In the U.S. and Canada, phone 1-800-333-1917. 

◆ +49 180 5 290220

◆ +44 870 606 9081

◆ Outside Brazil: (011) 55-11-268-7269

◆ Any city in Brazil, outside São Paulo 
City:

(011) 268-7269

◆ In São Paulo: 268-7269

◆ Asia Pacific: 65-740-4477

◆ Australia: +61 3 9690 9100
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If you need to contact HP Customer Support, do the following before 
you call:

1 Make sure that the OfficeJet Pro is plugged in and powered on, that 
the specified inkjet print cartridges are installed correctly, and that 
the recommended paper is properly loaded in the input tray.

2 Review the setup section (Chapter 2) and the troubleshooting 
section (Chapter 12) in this User’s Guide.

3 Try resetting the OfficeJet Pro by powering it off, then on again, 
using the white button in the lower right front corner of the 
product.

4 Call the HP FIRST toll-free number (see page 11-2) and/or check 
HP’s Internet site (http://www.hp.com/go/officejet-pro) for 
information that might help you quickly resolve your problem.

5 If you are still experiencing problems and need to speak with an 
HP Customer Support Representative:

a Have your serial number ready.

b Print a Self Test Page (see “Using the Self Test Page” 
on 12-3).

c Make a color copy.

d Be prepared to describe the problem you are experiencing in 
detail.

6 Call HP Customer Support.

Calling in the U.S. and Canada During Warranty
Call 208-323-2551 Monday through Friday from 6:00 am to 10:00 pm 
Mountain Standard Time (MST) and Saturdays from 9:00 am to 
4:00 pm MST. This service is free during the warranty period; 
however, your standard long-distance phone charges still apply.

Calling in the U.S. and Canada Post Warranty
If your product is not under warranty, you can call 1-800-999-1148. A 
per-call, out-of-warranty support fee will be charged to your credit 
card. You can also call 1-900-555-1500 ($2.50 per minute) from 
7:00 am to 6:00 pm MST and Saturdays from 9:00 am to 3:00 pm 
MST. Charges begin only when you are connected with a support 
technician. (Prices and hours are subject to change without notice.)
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Calling in Europe
The numbers listed below are current as of the printing date of this 
User’s Guide. For a list of current international HP Support Service 
numbers, visit this address:

http://www.hp.com/cpso-support/ecscphone

You can call the HP support center in the following countries. This 
service is free during the warranty period; however, your standard 
long-distance phone charges will apply.

Calling in Australia and New Zealand
Call (03) 9272-8000 in Australia or (09) 356 6640 in New Zealand. 
This service is free for 12 months from the date of original purchase; 
however, your standard long-distance phone charges still apply. For 
technical assistance after the free period, a $25 flat fee per single 
incident will apply.

Calling Elsewhere in the World
Contact your local dealer or nearest HP Sales and Support Office for 
information on obtaining technical assistance or hardware repair 
services.

Imaging for Internet Plug-In
For technical support for Imaging for Internet, visit our website:

http://image.hp.com

◆ Austria: 0660-6386 ◆ Italy: 022-641-0350

◆ Belgium (Dutch): 02-626-8807 ◆ Netherlands: 020-606-8751

◆ Belgium (French): 02-626-88-06 ◆ Norway: 22-11-6299

◆ Denmark: 39-29-4099 ◆ Portugal: 01-441-7199

◆ Europe (English): +44-171-512-5202 ◆ Spain: 902-321-123

◆ Finland: 02-03-47-288 ◆ Sweden: 08-619-2170

◆ France: 01-43-623-434 ◆ Switzerland (French & 
German): 084-880-1111

◆ Germany: 0180-525-8143 ◆ United Kingdom: 
0171-512-5202

◆ Ireland: 01-662-5525
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Get Help from Caere for OmniPage LE

U.S. Support
In the U.S., call 408-395-8319, or fax Caere at 408-395-5120. 

International Support
Internationally, call one of the following numbers, or fax Caere at 
+49 (0) 180 523 53 12.

You can also visit Caere’s website at the following address:

http://www.caere.com

Get Help from Adobe for PhotoDeluxe

U.S. Support
If you need assistance with Adobe PhotoDeluxe, in the U.S., call 
206-628-5727. 

Dial-Up Service for U.S. Users
Product support and information for Adobe PhotoDeluxe are available 
through the following services:

◆ English (Australia, New Zealand): +61 (0) 2 9450 0777

◆ English (Europe): +49 (0) 180 523 52 81

◆ French: +49 (0) 180 523 52 90

◆ German: +49 (0) 180 523 52 82

◆ Italian: +49 (0) 523 52 73

◆ Spanish (Europe): +49 (0) 180 523 52 74

Service How to Contact Service Provided
Adobe BBS 206-623-6984 updates/text/files

America Online Keyword ADOBE forum/updates

CompuServe ADOBEAPP forum/updates

Fax 206-628-5737 common Q&A

Internet techdocs@adobe.com e-mail help

World Wide Web http://www.adobe.com updates/text/files



HP OfficeJet Pro User’s Guide 11-7

International Support
These numbers are for international Adobe users.

Dial-Up Service for International Users

Get Help from Symantec for WinFax PRO
For technical assistance for WinFax PRO, contact Symantec on the 
World Wide Web at the following address:

http://www.symantec.com

Support Available
Symantec offers Standard Care, free of charge for all registered users 
for 90 days from the date of the first support call. 

North America
In the U.S., call 716-843-1018. In Canada, call 416-441-3301.

◆ Austria: Int + 44-131-451-6882

◆ Belgium: Int + 44-131-451-6883

◆ France: Int + 44-131-451-6889

◆ Germany: Int + 44-131-451-6884

◆ Italy: Int + 44-131-451-6890

◆ Netherlands: Int + 44-131-451-6885

◆ Sweden: Int + 44-131-451-6886

◆ Switzerland: Int + 44-131-451-6887

◆ UK and Ireland: Int + 44-131-451-6888

Service How to Contact Service Provided
CompuServe ADOBEAPP forum/updates

Faxback dial number listed above, and 
select option 3

common Q&A

World Wide 
Web

http://www.adobe.com updates/text/files
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International
Symantec offers telephone support in English, French, German, and 
Dutch from 9:00 a.m. to 5:00 p.m. CET Monday through Friday.

Numbers for Specific Countries

◆ Dutch (+31) 071 524 7270

◆ English (+44) 0171 616 5810

◆ French (+33) 1 64 53 80 70

◆ German (+49) 069 66410360

Country Phone Fax
Austria +43 1 50 137 5020 +43 1 50 137 5025

Belgium +32 271 31 700 +32 271 31 725

Denmark +45 354 45700 +45 354 45725

Finland +358 9229 30410 +358 9229 30425

France +33 1 645 38050 +33 1 645 38055

Germany +49 69 664 10300 +49 69 664 10333

Ireland +353 1 8118032 +353 1 8118033

Italy +39 2 482-70000 +39 2 482-70025

Luxembourg +352 29 84 795020 +352 29 84 795025

Netherlands +31 20 504 0565 +31 20 504 0566

Norway +47 23 053300 +47 23 053325

Sweden +46 870 39 615 +46 870 39 624

Switzerland +41 1 2126262 +41 1 2126264

United Kingdom +44 1711 61 665600 +44 171 61 65700
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Troubleshooting 12
This chapter presents procedures for resolving paper jams in the paper 
tray and automatic document feeder. It also lists messages that may 
appear on the HP OfficeJet Pro front panel display or on your 
computer screen. For more troubleshooting help, see 
“Troubleshooting” in the 1170C Series Toolbox. See “1170C Series 
Toolbox” on page 10-3 for instructions on how to access and use the 
Toolbox.

How to Clear a Paper Jam in the Automatic Document Feeder
You will see the following message on the front panel display: 
“Automatic Document Feeder Jam. Clear jam then press 
Select/Resume.”

1 Lift the automatic document feeder to expose the paper jam.

2 Gently remove the paper.

3 Replace your originals in the automatic document feeder.

4 Press the Select/Resume button on the front panel to continue.

How to Clear a Paper Jam in the Paper Tray

Paper Jam with Front Panel Message
The message “Paper Jam” appears on the OfficeJet Pro front panel 
display when paper cannot feed from the bottom paper tray properly.
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To resolve this problem:

1 Press and hold down the Select/Resume button. 

When you do this, the paper rollers in the HP OfficeJet Pro move 
forward to help eject the jammed paper. 

2 If this does not work, press and hold down Select/Resume again.

The paper rollers move in reverse. 

3 If the paper is still jammed, repeat steps 1 and 2 to move the paper 
rollers forward and backward.

4 Gently remove the paper.

5 If all else fails, remove the paper tray by pinching together the two 
levers under the paper tray. Pull the tray toward you, and gently 
remove the jammed paper. Then slide the paper tray back into the 
copier.

6 Turn the copier off, then on again to continue copying.

Paper Jam with No Front Panel Message
If paper has jammed in the copier, but no message is displayed, press 
and hold down the Select/Resume button on the front panel, then 
press the Paper Type button. Then follow the directions on page 12-1.

How to Use the Self Test Page
The Self Test Page lets you know whether the OfficeJet Pro is 
operating properly. It lists current, default front panel settings and tells 
whether the automatic document feeder is attached properly. You can 
also use the Self Test Page to check print alignment.

To print a Self Test Page:

1 Press the Menu button until the message “Self Test Page” appears 
on the front panel display.

2 Press the Select/Resume button.

The test page printout has a set of lines which should appear 
unbroken, and colored bars which should appear solid. The 
intensity of the colors will vary, depending on the type of paper 
you are using (that is, plain paper, HP Premium InkJet Paper, and 
so on).
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3 Check to make sure the margins are aligned and not skewed.

a Fold the Self Test Page in half carefully so that the “A” and 
the “C” along the left margin line up.

b Line up the equal signs (=).

c Verify that the vertical line next to the “A” appears between 
the two vertical lines next to the “C” (does not have to be 
centered). 

4 If the alignment is satisfactory, the copier mechanism is working 
properly.

If the alignment is not satisfactory, see “Troubleshooting” in your 
1170C Series Toolbox, and read the “Self-test page” topic.

5 If the Troubleshooting help does not resolve the problem, contact 
HP Customer Support. See “HP Customer Support” on 
page 11-3.

Aligning Cartridges
Use the Align Cartridges feature whenever you install new print 
cartridges. See “Step 8 — Align Your Tri-Color and Black Print 
Cartridges” on 2-24 for step-by-step instructions.

Using the Self Test Page
Use the Self Test Page to check the print cartridges and to determine 
whether the automatic document feeder is successfully installed. 

To Print a Self Test Page:

1 Press the Menu button repeatedly until you see “Self Test” on the 
front panel display.

2 Press Select/Resume.

The message “Printing” appears on the front panel display, and a 
Self Test Page will be printed. See page 12-2 for more 
information.
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Cleaning Cartridges
Use the Clean Cartridges feature when the Self Test Page shows 
streaking or white lines through any of the colored bars. Do not clean 
cartridges unnecessarily. This wastes ink and shortens the life of your 
print cartridges.

To clean the cartridges:

1 Press the Menu button repeatedly until you see “Clean 
Cartridges” on the front panel display.

2 Press Select/Resume. 

The message “Printing a Cleaning Check Sheet” appears on the 
front panel display, and a Print Cartridge Cleaning Page will be 
printed.

NOTE If copy or print quality still seems poor after you clean the cartridges, replace 
the one that is affected.
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Front Panel Messages

Message What You Should Do

Power Save On. The front panel displays this message when the OfficeJet Pro 
has not been used for 12 hours or more. Press any button on 
the front panel or load originals in the automatic document 
feeder.

Door Open. Close cartridge 
door.

Close the print cartridge door.

Paper Jam. Press and hold 
Resume to eject paper.

To clear the paper jam, press and hold the Select/Resume 
button. The paper should eject. If this does not work, refer to 
the procedures on page 12-1.
If only one or two sheets of paper are in the paper tray, the 
OfficeJet Pro might not pick up the paper properly, causing a 
jam in the copier.
Remove the papers that are jammed, and add more paper to 
the paper tray.

ADF Paper Jam. Refer to “How to Clear a Paper Jam in the Automatic 
Document Feeder” on page 12-1.

Busy. Can’t start another 
copy job.

You will see this message when you try to start a new copy 
job before the first job is complete, or you try to change front 
panel settings while a copy job is in progress.
Wait until the first copy job is complete before trying to start 
another.

Out of Paper. Replace paper 
then press Resume.

If the paper tray is empty, load paper in the paper tray, and 
press Select/Resume.
If the paper is not inserted correctly, adjust the paper, then 
press Select/Resume.

Remove original from the 
document glass.

Remove the original from the document glass, then press the 
Select/Resume on the front panel to continue.

Remove and check (black or 
color) cartridge.

One of the print cartridges is either incorrectly installed, the 
wrong type, or defective.
Remove the print cartridge (black or tri-color), and then 
replace it in the carriage stall.
Make sure to remove the tape from the print cartridge, and 
close the latch securely.

No Cartridge. Insert (black 
or color) cartridge.

A print cartridge is missing. Insert the missing cartridge.

Remove and check black 
cartridge. Verify Part 
Number: C51645A.

The wrong black cartridge may be installed. Remove it, and 
replace it with the correct cartridge, part number C51645A.
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Remove and check color 
cartridge. Verify Part 
Number: C1823A.

The wrong tri-color cartridge may be installed. Remove it, 
and replace it with the correct cartridge, part number 
C1823A.

Unlock scanner. The scanner is locked. See “Step 3 — Unlock Your 
HP OfficeJet Pro” on 2-7 for unlocking instructions.

Cartridge carriage blocked. Unblock the cartridge, and turn power off then on again.

Scanner bulb failing. The scanner bulb is becoming too dim to work properly.
Turn power off, then on again. If the message continues and 
the light flickers or does not come on, your OfficeJet Pro 
needs to be serviced. See page 14-2 for more information.

Turn Power off then on 
again.

A system error has occurred that you cannot resolve 
yourself.
Turn power off, then on again. If this message appears 
repeatedly, or remains on the display, call HP Customer 
Support for help (see page 11-3).

Additional cleaning will be 
ineffective. Replace 
cartridge.

Replace the print cartridge.

Manual Feed. Insert paper 
and press Resume.

You are printing, and have requested Manual Feed in the 
Print Properties dialog.
Insert paper in the manual feed tray, and press 
Select/Resume.

Cannot connect to PC; see 
User’s Guide.

First, check to make sure your computer is turned on. If it is, 
next check the cable connection between your computer and 
the OfficeJet Pro. Be sure to use only the special IEEE-1284 
parallel printer cable that came with your product. The 
connection must be direct, not through any other parallel 
product, such as a CD-ROM drive.
After you have checked all connections, open the 1170C 
Series Toolbox. Click the Product Services tab, and select 
Check Product Communication. 
Then try to print or scan again. If the problem persists, one 
of the programs the OfficeJet Pro uses during scanning may 
not be installed, or may already be running. 
Check to be sure that the file hpmdlbia.exe is installed in 
your c:\windows\system folder. If it is, restart your computer 
and try again.
If it is not, you must reinstall the HP components. First, 
uninstall the HP components (see page 13-1). Then reinstall 
the HP components following the procedure on page 13-2.

Front Panel Messages (Continued)

Message What You Should Do
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On-Screen Messages

Message What You Should Do

Disk full. The image you are scanning will create a file that is too large 
to fit on the designated disk.
◆ Save the file on a different disk.

◆ Free up disk space, and try again.

◆ Save the image in a different format or resolution.

See the Scanning Tutorial for tips on scanning and file sizes.

Cannot find all the necessary 
files to run WinFax PRO. 
Reinstall WinFax PRO.

Symantec WinFax PRO has not been installed or has 
corrupted files. Close and save any open files. Uninstall 
Symantec WinFax PRO following the procedure on 
page 13-2. Then reinstall Symantec WinFax PRO CD 
following the procedure on page 13-3.

Can’t restart PictureScan. It 
is already running.

PictureScan or Caere OmniPage LE may already be running, 
or one of the programs may not have closed properly.
Save and close any open files. Then reboot your computer 
and try again.

Can’t find PictureScan or 
PictureScan is already 
running.

One of the programs the OfficeJet Pro uses during scanning 
may not be installed, or may already be running.
Save and close any open files. Then reboot your computer 
and try to scan again. If you are still unable to scan, you may 
be missing critical HP components. 
First, uninstall HP components (page 13-1). Then reinstall 
the HP components (page 13-2).

Verify that the OfficeJet Pro 
is turned on.

Make sure that the OfficeJet Pro is turned on. Press the white 
button in the lower right front corner of the product.

Make sure you are using the 
cable that came in your box.

You must use an IEEE-1284 cable with the OfficeJet Pro. 
The cable that came with your product meets this 
requirement. If you decide to buy a longer cable, make sure 
it is IEEE-1284 compliant. Using a different type of cable 
may cause communication problems.

Verify that the cable is 
securely connected to your 
OfficeJet Pro and directly to 
the parallel port of your PC.

Verify that the parallel cable is securely connected to your 
OfficeJet Pro and directly to the parallel port of your 
computer. Do not connect your OfficeJet Pro through a 
switch box pass-through device; communication errors may 
occur. When the cable is connected properly, turn your 
OfficeJet Pro off and then on again.
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Remove original from the 
document glass then press 
Select/Resume on the front 
panel.

An original sheet is already present on top of the document 
glass. Remove this original and press the Select/Resume 
button before you re-feed an original through the automatic 
document feeder.

Your scan has been 
cancelled due to 
communication failure.

1. If this is the first time you have attempted to scan from the 
OfficeJet Pro, the parallel cable between your computer 
may be loose or defective. Check both connections and try 
again.

2. A non-cable related communications error may have 
occurred. Select OK and restart the scan. You may need to 
restart your computer.

Can’t find all the necessary 
files to run WinFax PRO.

You need to install Symantec WinFax PRO. Follow the 
instructions on page 13-3.

On-Screen Messages (Continued)

Message What You Should Do
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Adding and Removing 
Software Programs 13
This chapter explains how to remove HP OfficeJet Pro software from 
your computer. It also explains how to reinstall the software, if 
necessary.

Uninstalling Software
When you install a software program on your computer, many files on 
your system are either added or changed because of the new program. 
When you need to remove a software program, you need to remove all 
files associated with that program, not just the files you see in a 
particular program folder. Do not simply remove the executable file 
from your hard drive. Be sure to “uninstall” it properly, using either the 
special uninstaller program that came with the product or using the 
Windows 95/98 “Add/Remove” feature, as instructed below. 

NOTE During the uninstall process, if you are asked whether you would like to 
remove Shared files, answer “No.” Other programs that use these files may 
not work properly if the files are deleted.

Uninstalling the HP OfficeJet Pro Product Software
1 From the taskbar, select Start, then select Settings and go to the 

Control Panel.

2 Double-click the Add/Remove Programs icon.

3 Select HP OfficeJet Pro 1170C Series, and click the 
Add/Remove button.

4 Go back to the Control Panel, and open the Printers folder.
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5 Select the HP OfficeJet Pro  printer, and delete it by selecting 
Delete from the File menu.

This step removes the HP OfficeJet Pro 1170C Series software.

6 Restart Windows.

Uninstalling Adobe PhotoDeluxe
1 From the taskbar, select Start, then select Uninstall 

PhotoDeluxe 2.0 from the Adobe PhotoDeluxe 2.0 program 
folder.

2 Follow the directions on the screen.

Uninstalling Caere OmniPage LE
1 Run OmniPage Limited Edition.

2 Under the Tools menu, select OCR Aware.

3 In the OCR Aware dialog, deselect Enable OCR Aware by 
clicking off its checkmark. Then click OK .

4 Restart Windows.

5 Delete the C:\OPLIMIT  folder.

Uninstalling Symantec WinFax PRO, Imaging for the 
Internet, and Microsoft Internet Explorer
1 From the taskbar, select Start, then select Settings and go to the 

Control Panel.

2 Click Add/Remove Programs.

3 Select the program you want to remove, and click the 
Add/Remove button. 

4 Follow the directions on the screen.

Reinstalling HP OfficeJet Pro Software

Installing HP Components Only
To reinstall only the HP software components (printing and scanning), 
follow the directions in Chapter 2, starting on page 2-14. When the 
“Insert CD-ROM #2” message is displayed, click Cancel.
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Installing HP OfficeJet Pro Partner Software
If you did not install some of the available third-party software 
programs when you installed your OfficeJet Pro, follow these 
procedures to install them separately.

1 Insert CD-ROM #2 in your computer’s CD-ROM drive.

2 From the task bar, select the Start menu, and then select Run.

3 Enter z:\setup (substitute your CD-ROM drive letter for 
the “z”).

The “Install Software” screen appears. 

4 Make sure there is a check in the box next to the software product 
you want to install, and click Next>. 

NOTE If you are installing Symantec WinFax PRO, be sure to have your 
Windows 95/98 installation CD-ROM available.

5 Follow the instructions on the screen.

For more information, see the software installation procedure 
beginning on page 2-14.

Installing the Office 97 Utility
If you install Office 97 after installing your HP OfficeJet Pro 
software, you must run a special program before you can scan 
pictures into these programs. The procedure below explains how to 
run the utility.

1 Insert CD-ROM #2 into your CD-ROM drive.

2 From the taskbar, select Windows Explorer.
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3 Navigate to your CD-ROM drive, and open the HP ScanPicture 
Office 97 Patch folder.

4 Double-click setup.exe. 

The “InstallShield” dialog box is displayed.

5 Click Yes to install the Office 97 patch.

6 When the patch has been installed, click OK .

7 Restart your computer.

You will now be able to scan while working in your Office 97 
programs.
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Hewlett-Packard 
Limited Warranty 14
HP OfficeJet Pro 1170C, 1175C

Duration of Limited Warranty (Hardware): 1 Year

Duration of Limited Warranty (Software): 90 Days

Duration of Limited Warranty (Print Cartridges): 90 Days

To review a complete copy of your warranty, see “Warranty 
Information” in your HP OfficeJet Pro 1170C Series Toolbox.

Warranty Service

Express Service
To obtain HP express repair service, the customer must contact an HP 
service office or an HP Customer Support Center for basic 
troubleshooting first.

If a customer unit needs a minor part replacement and these parts can 
normally be replaced by the customer, the customer-replaceable 
components may be serviced through expedited part shipment. In this 
event, HP will prepay shipping charges, duty and taxes; provide 
telephone assistance on replacement of the component; and pay 
shipping charges, duty, and taxes for any part that HP asks to be 
returned.

For some repairs, the HP Customer Support Center may direct 
customers to designated Authorized Service Providers who are 
certified by HP to service the HP OfficeJet Pro.

If you need to return your OfficeJet Pro to HP for repair, HP will 
expedite the repair of your unit by using an express delivery service to 
expedite the return of the repaired or exchanged unit.
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Warranty Upgrades
Extended warranties and service option upgrades may be obtained 
through your local HP authorized dealer or HP service centers.

In the U.S. and Canada, extended warranties may also be obtained by 
calling HP at 1-800-446-0522. For on-site service contracts, call 
1-800-835-4747.

Returning Your HP OfficeJet Pro for Service

Before You Call
Before you call HP Customer Support:

1 Make sure that the OfficeJet Pro is plugged in and powered on, that 
the specified inkjet print cartridges are installed correctly, and that 
the recommended paper is properly loaded in the input tray.

2 Review the Setup chapter and Troubleshooting chapter in this 
User’s Guide.

3 Try resetting the OfficeJet Pro by powering it off, then on again, 
using the power button in the lower front corner of the product.

4 Call the HP FIRST toll-free number (see page 11-2) and/or check 
HP’s Internet site (http://www.hp.com/go/officejet-pro) for 
information that might help you quickly resolve your problem.

5 If you are still experiencing problems and need to speak with an 
HP Customer Support Representative:

a Have your OfficeJet Pro serial number ready.

b Print a Self Test Page (see page 12-2).

c Make a color copy.

d Be prepared to describe the problem you are experiencing in 
detail.

6 Call HP Customer Support. See page 11-3 for more information.

After you receive authorization for hardware service from 
HP Customer Support Center, prepare the OfficeJet Pro for shipment 
and pack it a protective carton. We recommend you save the original 
shipping container for this purpose.

NOTE In-transit damage is not covered by the warranty, so always insure your 
shipment.
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Prepare Your HP OfficeJet Pro for Shipment
1 Turn on the HP OfficeJet Pro, and leave it on for at least 

2 minutes.

2 Raise the document cover, then raise the print cartridge access 
cover and use it to prop open the document cover.

3 Remove both print cartridges and close the print cartridge 
latches. Place print cartridges in an airtight bag so they will not 
dry out, and put them aside (do not send them with the 
OfficeJet Pro, unless instructed to by the HP customer support 
call agent).

CAUTION Print cartridges that remain inside may damage your OfficeJet Pro.

4 Insert the orange packing insert (if available).

5 Turn off the HP OfficeJet Pro.

You will see the message “Shutting Down” on the front panel 
display.

6 To prevent damage to the HP OfficeJet Pro during shipping, lock 
the scanner.
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7 Pack the OfficeJet Pro for shipment using the original packing 
materials. 

If you do not have the original packaging materials, you can 
request a replacement package set from HP Customer Support.

8 Please also include the following items in the box:

◆ A brief description of symptoms for service personnel 
(samples of print quality problems are helpful).

◆ A copy of the sales slip or other proof of purchase to establish 
the warranty coverage period.

◆ Your name, address, and a phone number where you may be 
reached during the day.

NOTE Shipping damage caused by improper packaging is not covered under the 
warranty.
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Technical Information 15
System Requirements
Hewlett-Packard software solution

Minimum Recommended
(HP Components Only) (Typical installation with all components)

Processor 486/66 MHz Pentium

DOS (disk operating system) 6.0 or later 6.0 or later

Windows 95 95/98

RAM 16 MB 32 MB

Disk Space Needed 45 MB 167 MB

Video Display 256 colors 16.7 million colors

Media CD-ROM drive CD-ROM drive

Parallel Port Bi-directional IEEE-1284 Enhanced 
Capabilities Port (ECP)

If using Symantec 
WinFax PRO

Fax modem Fax modem
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Adobe PhotoDeluxe

◆ 70 MB+ available hard disk space 

◆ 16 MB+ RAM 

◆ 256 color or greater display monitor

◆ Sound card (recommended)

Caere OmniPage Limited Edition

◆ 12 MB+ available hard disk space 

◆ 12 MB+ RAM

Symantec WinFax PRO

◆ 25 MB+ available hard disk space

◆ 16 MB+ RAM 

◆ Class 1, Class 2, Class 2.0 or 
CAS-compatible fax/voice modem

◆ Sound card (for TalkWorks)

◆ VGA video minimum

Imaging for Internet 

◆ 12 MB+ available hard disk space

◆ 16 MB+ RAM

◆ Netscape Navigator 2.02 (or higher) or 
Internet Explorer 3.01 (or higher) (will 
also work with other browsers that support 
the Netscape plug-in interface)

Microsoft Internet Explorer

◆ 1–3 MB of available hard disk space, plus 
an additional 10–15 MB if installing 
Microsoft Network components

◆ 8 MB+ RAM 

Speed Specifications
Copy Speeds
Copy speed is related to the complexity of the 
document.

Black Copy Speed (letter-sized, text)
Fast mode: 9 pages per minute

Normal mode: 8 pages per minute

Color Copy Speed 
(letter-sized, mixed text and graphics)
Fast mode: 3 pages per minute

Normal mode: 1 page per minute

Color Copy Speed 
(letter-sized, full page, full-color graphics)
Fast mode: 2.0 pages per minute

Normal mode: 0.5 page per minute

Printing Speeds
Printing speed is related to the complexity of 
the document.

Black Print Speed (letter-sized, text)1

Econo-Fast mode: 9 pages per minute

Normal mode: 7 pages per minute

Color Print Speed1  

(letter-sized, mixed text and graphics)
Econo-Fast mode: 5 pages per minute

Normal mode: 1.5 page per minute

Color Print Speed2 
(letter-sized, full page, full-color graphics)
Econo-Fast mode: 2 pages per minute

Normal mode: 0.5 page per minute

Scanning Speeds2

At 100 dpi
Color photograph: Normal (8 bit) – 10 secs – 
3 x 5 in.

Color photograph: Best (24 bit) – 10 secs – 
3 x 5 in.

At 300 dpi
Color drawing (24 bit): 21 secs – 3 x 5 in.

OCR Scanning (300 dpi)
Text page (4 bit): 31 secs – 8.5 x 11 in.

1 Actual speed varies by content of files and 
software application.

2 Actual speed varies by content.
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Copy Margins
Copy at 100% or Clone Option:
Margin Letter

(8.5 x 11 in.)

A4
(210 x 297 mm)

Top 0.07 in. 1.8 mm

Bottom 0.5 in. 12.7 mm

Left 0.2 in. 3.3 mm

Right 0.2 in. 3.3 mm
Copy at 100% when document feeder is 
installed and user is copying from the 
glass onto Letter-size paper:
Margin Letter

(8.5 x 11 in.)

Top 0.07 in.

Bottom 0.5 in.

Left 0.25 in.

Right 0.25 in.
All other Reduce/Enlarge Settings:
Margin Letter

(8.5 x 11 in.)

A4
(210 x 297 mm)

Top 0.5 in. 12.7 mm

Bottom 0.5 in. 12.7 mm

Left 0.38 in. 9.4 mm

Right 0.38 in. 9.4 mm

Functional Specifications
Operating System Compatibility
Windows 95/98

Network – Netware 3.12, 4.1 (printer only)

Windows 3.1 support (OfficeJet Pro 1150C 
compatibility)

Windows NT 4.0

Software
OCR Software – Caere OmniPage Limited 
Edition – Caere Corporation

Image Editor – Adobe PhotoDeluxe

HP ScanPicture Utility – HP integration 
software for Windows 95/98

HP OfficeJet Pro PictureScan – TWAIN 
compliant scanning software

Integrated installer for CD-ROM

PC Fax – WinFax PRO – Symantec 
Corporation

Imaging for Internet – HP plug-in for Web 
browsers 

FontSmart 2.0 – Font management utility

I/O
Centronics IEEE-1284 bi-directional

MLC
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Paper Sizes

Copying
U.S. letter-sized (8.5 x 11 in.)

European A4 (210 x 297 mm)

Printing
U.S. letter-sized (8.5 x 11 in.)

U.S. legal (printing only) (8.5 x 14 in.)

U.S. executive (7.25 x 10.5 in.)

U.S. no. 10 envelope (4.12 x 9.5 in.)

Index card (4 x 6 in.)

Index card (5 x 8 in.)

European A4 (210 x 297 mm)

European A5 (148 x 210 mm)

European DL envelope (220 x 110 mm)

European C6 envelope (114 x 162 mm)

European A6 card (105 x 148.5 mm)

Avery InkJet Labels:

Custom sizes: Width: 3.94–8.5 in. 
(100–216 mm); Length: 5.79–14 in. 
(148–356 mm)

Duty Cycle 
Maximum Monthly Usage: 3,000 pages

Paper Weight
16–36 lb (60–135g/m2)

Envelope Weight
75–90 g/m2 (20–24 lb)

Card Stock Weight
110–200 g/m2 (110 index max; 8.5 pt max 
thickness)

Automatic Document Feeder 
Requirements
Paper weight of originals: 16–24 lb 
(60–90 g/m2)

Maximum number of originals: 30

Black Resolution - Printing
Fast: 300 x 300 dpi

Normal: 600 x 600 dpi

Best: 600 x 600 dpi

Color Resolution – Printing
Fast: 300 x 300 dpi

Normal: 600 x 300 dpi CREt

Best: 600 x 600 dpi CREt

PC Fax Resolution (using Scan To Fax 
button):
Standard 200 x 100 dpi (default)

Fine 200 x 200 dpi

Colors
Up to 16.8 million

Language
PCL3 with color printer language

Fonts
FontSmart Technology: 126 scalable fonts for 
Windows

DOS: 4 built-in scalable typefaces—Courier, 
CG Times, Univers, Letter Gothic—15 fonts

Other
Resolution Enhancement technology 
(REt)/Color (CREt) ColorSmart technology, 
HP Real Life Imaging System
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Power Specifications
Source Voltage
100–240V

Frequency
50–60 Hz

Current
1A maximum

Power
45 W maximum

Environmental 
Specifications
Operating ranges
5o–40oC (41o–104oF)

Recommended ranges
15o–35oC (59o–95oF)

Humidity
15%–80% RH non-condensing

Non-operating ranges
40o–70oC (104o–140oF)

Physical Specifications
Height
19 in. (48.26 cm)

Width
21.25 in. (54 cm)

Depth
17.7 in. (43.2 cm)

Weight
36.85 lb (16.38 kg)

Regulatory Notices
FCC Statement (U.S.A.)
The United States Federal Communications 
Commission (in 47 CFR 15.105) has 
specified that the following notice be brought 
to the attention of users of this product.

Declaration of Conformity: This equipment 
has been tested and found to comply with the 
limits for a Class B digital device, pursuant to 
part 15 of the FCC Rules. Operation is subject 
to the following two conditions: (1) this 
device may not cause harmful interference, 
and (2) this device must accept any 
interference received, including interference 
that may cause undesired operation. Class B 
limits are designed to provide reasonable 
protection against harmful interference in a 
residential installation. This equipment 
generates, uses, and can radiate radio 
frequency energy and, if not installed and 
used in accordance with the instructions, may 
cause harmful interference to radio 
communications. However, there is no 
guarantee that interference will not occur in a 
particular installation. If this equipment does 
cause harmful interference to radio or 
television reception, which can be 
determined by turning the equipment off and 
on, the user is encouraged to try to correct the 
interference by one or more of the following 
measures:

◆ reorient the receiving antenna

◆ increase the separation between the 
equipment and the receiver

◆ connect the equipment into an outlet on a 
circuit different from that to which the 
receiver is connected

◆ consult the dealer or an experienced 
radio/TV technician for help

Product Regulations Manager, 
Hewlett-Packard Company, San Diego 
619-655-4100.
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The user may find the following booklet 
prepared by the Federal Communications 
Commission helpful: How to Identify and 
Resolve Radio-TV Interference Problems. 
This booklet is available from the US 
Government Printing Office, Washington 
DC, 20402. Stock No. 004-000-00345-4.

CAUTION : Pursuant to Part 15.21 of the 
FCC Rules, any changes or modifications to 
this equipment not expressly approved by the 
Hewlett-Packard Company, may cause 
harmful interference and void the FCC 
authorization to operate this equipment.

Telecommunications General Approval (UK)

Pursuant to Section 22 of 
Telecommunications Act of 1984, this 
product is approved for secondary attachment 
to approved primary attachment devices 
connected to the telecommunications network 
under the General Approval 
(NS/G/1234/5/100003).

DOC Statement (Canada)
Le présent appareil numérique n’émet pas de 
bruits radioélectriques dépassant les limites 
applicables aux appareils numériques de la 
classe B prescrites dans le Règlement sur le 
brouillage radioélectrique édicté par le 
ministère des Communications du Canada.

This digital apparatus does not exceed the 
Class B limits for radio noise emissions from 
digital apparatus set out in the Radio 
Interference Regulations of the Canadian 
Department of Communications.

Geräuschemission
LpA < 70 dB
am Arbeitsplatz
im Normalbetrieb
nach DIN 45635 T. 19

VCCI-2

printer will insert
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Declaration of Conformity 
(According to ISO/IEC Guide 22 and EN45014)

Hewlett-Packard Company, 16399 West Bernardo Drive, San Diego, California 92127-1899, 
USA.

Hewlett Packard Company, Singapore Pte. Ltd. 20 Gul Way, Singapore, 629196.

Singapore Shinei Sangyo Pte. Ltd., Blk33 Marsiling Ind. Est., Rd 3#04-01/06, Singapore 
3622816.

declares, that the product

Supplementary Information
LED’S IN THIS PRODUCT ARE CLASS I IN ACCORDANCE TO IEC825-1.

The Product herewith complies with the requirements of the Low Voltage Directive 
73/23/EEC and EMC Directive 89/336/EEC, and carries the CE marking accordingly.

Product Names: HP OfficeJet Pro 1175C

Model Number(s): Model C5364A

Product Options: OfficeJet Pro 1175C includes ADF, HP Pt. No. C5365-60625

conforms to the following Product Specifications:

Safety: EN60950:1992 +A1, A2, and A3

IEC 950:1991 +A1, A2, A3, and A4

UL1950, 3rd Edn: 1995

CSA22.2 No. 950 3rd Edn: 1995

NOM-016-SCFI-1993

EMKO TSE(74-SEC)207/1994

EMC: CISPR22:1993/EN55022:1994 - Class B

EN50082-1:1992

IEC 1000-4-2:1995 / prEN55024-2:1992 - 4kV CD, 8kV AD

IEC 1000-4-3:1995 / prEN55024-3: 1991 - 3V/m

IEC 1000-4-4:1995 / prEN55024-4: 1993 - 1.0 kV Power Line

ENV 50141:1993

IEC 555-2:1982/EN60555-2:1987

IEC 555-3:1982/EN60555-3:1987

FCC Part 15 - Class B/ICES-003, Issue 2/VCCI-2
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Ordering Accessories and Supplies 
In the U.S., you may order printer supplies by calling HP Direct (800) 538-8787 for the name 
of your local authorized HP dealer. Outside the U.S., call your local authorized HP dealer.

Supplies/Accessories HP Reorder Number
Print cartridges
Black print cartridge C51645A
Tri-color print cartridge C1823A

Papers
HP Premium InkJet Paper, Letter

(200 sheets, 8.5 x 11 in.) C51634Y
HP Premium InkJet Paper, A4

(200 sheets, 210 x 297 mm) C51634Z
HP Bright White InkJet Paper, Letter

(500 sheets, 8.5 x 11 in.) C1824A
(200 sheets, 8.5 x 11 in.) C5976A

HP Bright White InkJet Paper, A4
(500 sheets, 210 x 297 mm) C1825A
(200 sheets, 210 x 297 mm) C5977A

HP Premium Heavyweight InkJet Paper, Letter
(15 sheets, 8.5 x 11 in.) C1852A

HP Premium Heavyweight InkJet Paper, A4
(15 sheets, 210 x 297 mm) C1853A

HP Premium Photo Paper, Letter
(15 sheets, 8.5 x 11 in.) C6039A

HP Premium Photo Paper, A4
(15 sheets, 210 x 297 mm, Europe) C6040A
(15 sheets, 210 x 297 mm, Asia) C6043A

HP Premium Transparency Film, Letter
(50 sheets, 8.5 x 11 in.) C3834A
(20 sheets, 8.5 x 11 in.) C3828A

HP Premium Transparency Film, A4
(50 sheets, 210 x 297 mm) C3835A
(20 sheets, 210 x 297 mm) C3832A

HP Iron-On T-Shirt Transfers
(10 sheets, 8.5 x 11 in.) C6049A

Customer Replaceable Parts
HP IEEE-1284 A-B Parallel Cable:

2 meter length C2950A
3 meter length C2951A

Document Cover C5300-60015
Paper Tray C5364-60339
HP OfficeJet Pro User’s Guide Call dealer for part number for your language.
Right side panel of case C5300-40023
Print cartridge access cover C5300-40014
Service station kit C5300-60043
Front panel overlay Call dealer for part number for your language.
Power cord Call dealer for part number for your location.



HP OfficeJet Pro User’s Guide I-1

index

Numerics
1170C Series Toolbox 10-3

How Do I tab 10-4
how to run 10-4
Product Services tab 10-4
Troubleshooting tab 10-4

A
Adobe PhotoDeluxe

technical specifications 15-2
aligning print cartridges 2-24
alignment

horizontal 2-24
vertical 2-25

Auto Fit 3-5
automatic document feeder

how to clear a paper jam 3-11, 12-2
loading originals 7-5
paper specifications 7-5
tips 3-11

B
background

color 3-8
Best quality 3-4
bi-directional communications test 2-17
bi-directional mode 2-3
black

and white copies 3-3
copy speed 15-2
print cartridge 2-11
resolution 15-4

blank page 12-7
boldface, what it means in the user’s guide 1-2

C
Caere OmniPage LE

technical specifications 15-2
cancelling copying 3-10
cartridges, print

aligning 2-24, 12-3
cleaning 12-4

inserting 2-10
ordering 15-8

caution, what this label means in the user’s 
guide 1-2

cleaning
cartridges 12-3
copier glass 9-1
exterior case 9-1

clear/stop button 3-10
Clone 100% 3-6
color

backgrounds 3-8
copies 3-3
copy speed 15-2
enhance light colors 3-7, 3-8
how to change color intensity 3-7
intensity 3-7
print cartridge 2-10, 2-11
resolution 15-4
text enhancement 3-7, 3-8

CompuServe support 11-3
connecting OfficeJet Pro to computer parallel 

port 2-2
copies

black and white 3-3
color 3-3
how to make 3-2
making lighter or darker 3-7
multiple 3-3, 3-4, 3-5
paper size 3-9
placing originals in automatic document 

feeder 3-2
placing originals manually 3-2
quality problems 12-4
using the automatic document feeder 3-2

copy quality
Best setting 3-4
changing setting 3-5
Fast setting 3-4
Normal setting 3-4
settings available 3-4

copying
canceling 3-10

Custom 100% 3-5



I-2 Index

D
damage

parts 2-5
darkness, copy 3-7
declaration of conformity 15-7
defaults

changing 3-10
factory 3-10
front panel 3-10
indicator 3-10
paper size 2-14
when reset 3-4

dial-up services 11-6
disk operating system (DOS) 15-1
DOS (disk operating system) 15-1

E
ECP (extended capabilities port) mode 2-3
ELC (Enhance Light Colors)

changing the setting 3-8
enlarging 3-5
Entire 91% 3-5
environmental specifications 15-5
error messages 12-5, 12-7

F
factory defaults 3-10

how to reset 3-10
Fast quality 3-4
front panel

attaching overlay 2-6
language 2-14, 3-9
messages 12-5

G
graphics

copy speed 15-2
graphics copy speed 15-2

H
heavyweight inkjet paper 7-2
help

1170C Series Toolbox 10-3
Adobe PhotoDeluxe 10-2, 11-6
Caere OmniPage LE 10-2, 11-6
CompuServe support 11-3
HP Customer Support 11-5
HP FIRST 11-2
HP PictureScan 10-3
Imaging for Internet 11-5
international 11-5
internet 11-1
Scanning Tutorial 10-2
support during warranty 11-4
support in Australia and New Zealand 11-5
support post warranty 11-4
Symantec WinFax PRO 10-2, 11-7
Tour 10-1
Tutorial 10-2
worldwide 11-5

horizontal alignment 2-24
HP

customer support 11-3
distribution center 11-1
help 11-1
HP FIRST 11-2
internet website address 11-1
on-line Product Tour 10-1
on-line services 11-1
papers to use 7-1

HP iron-on transfers
loading 7-4

I
Imaging for Internet

internet website address 11-5
technical specifications 15-2

inkjet paper 7-2
loading 7-4

inserting print cartridges 2-10
installing

HP OfficeJet Pro software 13-2
Office 97 patch 13-3
third-party software 13-3

international support 11-5
internet 11-1
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how to stop using Windows 95 4-3
print settings 4-2

Product Tour 10-1

Q
quality, copy 12-4
quotation marks, what they mean in the user’s 

guide 1-2

R
reduce/enlarge

Auto Fit 3-5
changing settings 3-6
Clone 100% 3-6
Custom 100% 3-5
Entire 91% 3-5
Mirror 100% 3-6
Normal 100% 3-5
overview 3-5
Poster 400% 3-6

reducing 3-5
regulatory information 15-5
requirements, system 15-1

S
Scan To Fax 3-4, 6-1
scanner

light 3-1, 4-1
unlocking 2-7

scanning
editing pictures 5-7
methods available 5-1
pictures in TWAIN-aware programs 5-3
pictures or text using Scan To Fax 6-1
pictures using PictureScan 5-5
pictures using WinFax PRO 6-2
resolution 5-2
summary table of methods 5-2
text using Acquire Text 5-4
text using Caere OmniPage LE 5-6
tips 5-2
using HP Scan Picture 5-2

self test page 12-2, 12-3
service, copier 14-2
setup

aligning print cartridges 2-24
choosing location for OfficeJet Pro 2-1
connecting cable and power cord 2-12
front panel overlay 2-6
inserting print cartridges 2-10
installing software 2-14
loading paper 2-8
power cord 2-12
setting front panel language and default paper 

size 2-14
summary 2-1
unlocking scanner 2-7
unpacking 2-4

shipping copier 14-3
size

copy paper 3-9
software

installing 2-14, 13-2
installing Office 97 patch 13-3
uninstalling 13-1

specifications
environmental 15-5
functional 15-3
physical 15-5
power 15-5
speed 15-2

speed specifications 15-2
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supplies
ordering 15-8

support
Adobe 11-6
Caere 11-6
CompuServe 11-3
HP audio tips 11-2
HP FIRST 11-2
Imaging for Internet 11-5
internet 11-1
on-line services 11-1
Symantec 11-7

switch box 2-2
Symantec WinFax PRO 3-4, 6-1

technical specifications 15-2
system requirements 15-1

T
technical specifications

Adobe PhotoDeluxe 15-2
automatic document feeder 

requirements 15-4
Caere OmniPage LE 15-2
colors 15-4
copy margins 15-3
copy speed 15-2
duty cycle 15-4
envelope weight 15-4
environmental 15-5
fax resolution 15-4
fonts 15-4
Imaging for Internet 15-2
language 15-4
Microsoft Internet Explorer 15-2
paper sizes 15-4
paper weight 15-4
physical 15-5
power 15-5
printing resolution 15-4
printing speed 15-2
scanning speed 15-2
Symantec WinFax PRO 15-2

text enhancement 3-8
turning it off 3-8

tip, what this label means in the user’s guide 1-2
Tour 10-1

how to run 10-1

transparencies
loading 7-4
tips on using 7-4

transparency film 7-1
loading 7-4

troubleshooting 12-1
Tutorial 10-2

how to run 10-2

U
uninstalling

Adobe PhotoDeluxe 13-2
Caere OmniPage LE 13-2
HP OfficeJet Pro software 13-1
Imaging for Internet 13-2
Microsoft Internet Explorer 13-2
Symantec WinFax PRO 13-2

unlocking scanner 2-7
unpacking HP OfficeJet Pro 2-4

V
vertical alignment 2-25

W
warning, what this label means in the user’s 

guide 1-2
warranty 14-1

express service 14-1
preparing your copier for shipment 14-3
returning OfficeJet Pro for service 14-2
upgrades 14-2
what to do before you call 14-2

website
current list of HP papers 7-1
updated product information 11-1




